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INTRODUCTION 
 
Thank you for purchasing TroopMaster® Millennium, by far the most powerful and popular troop 
management system on the market! You will soon be joining the many thousands of your fellow 
Scouters who save time and effort using programs from the flagship of Scouting software, Troopmaster 
Software, Inc. 
 
TroopMaster offers significant advantages over similar software products: 
 

• TroopMaster was written specifically for Boy Scout Troops by professional software 
developers, one with over 22 years experience in Scouting, and his son, an Eagle Scout 
(1986). It �understands� how scout units operate and can track your scouts' progress to 
provide information that would be impossible on a simple database management system.  

 
• The software is intuitive and very easy to use. While it takes time to initially enter all of 

your unit data, maintaining the data from that point will be a breeze! 
 
• Most BSA rules for rank advancement are programmed into the system. For example, 

Eagle-required merit badges are monitored for you and advancement is not allowed until 
the minimum requirements are completed. Also, the Participation, Position of 
Responsibility, 2nd/1st Class Activity, and Service Project requirements are monitored 
for you and completion dates entered as soon as the respective requirements are 
complete. TroopMaster will automatically place each scout�s completed merit badges 
under the appropriate ranks for you. 

 
To get the most from your new software, we recommend the following:  
 

(1) Read this User�s Manual. It is especially important that you read Chapters 5, 6, 7, 15, and 
Appendix B. It is critical that you read Appendix C. We also recommend that you read all 
items that are highlighted using the following conventions: 

 
 

Information that is critical to utilizing TroopMaster is displayed as bold, red text within 
a shaded box. 

 
Information that requires special emphasis is displayed as black text within a shaded box. 

 
Helpful hints for getting the most out of your system are displayed in green text next to a  
light bulb icon. 
 

 
(2) Back up your data. Don't let a hardware failure force you to start over. See the �Making 

Backups� chapter for recommended procedures.  
 
You are now ready to get started. If we have achieved our goal, you soon will be spending less time with 
paperwork and more time with the scouts who need you! Happy Scouting! 
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WHAT'S NEW IN THIS VERSION 
 
TroopMaster incorporates over 200 user-suggested improvements! The following is a summary of the 
major improvements: 

 
• Conversion to 32-bit technology with corresponding improvements to the user interface and ease 

of use. 
 

• Data links between family members (e.g., siblings, parents, adult leaders, merit badge 
counselors, etc.) so that updating a data item in any member�s record will automatically update 
the records for all related family members. 

 
• Scout/adult personal data dialogs now have an option to attach photographs of your members, 

which TroopMaster will use to create a photo directory of your unit. Also, the Unit General 
Information dialog lets you attach a photo of the whole unit.  

 
• Fields for more email addresses (for parents, etc.) plus the ability to create email messages from 

within the program. Also, any report can be attached to email messages in any of several optional 
formats. 

 
• Capability to create individual reports (such as the Individual Progress or Individual History 

reports) for all scouts in the unit and automatically email them to the scouts. That is, 
TroopMaster will automatically create a separate email message for each scout and attach that 
scout�s report to his message! 

 
• We�ve incorporated file compression technology so that database backups and satellite 

distributions will be automatically compressed into a single, very small file. Also, data backups 
and satellite distributions can easily be emailed, and TroopMaster will automatically de-
compress the files for the recipient. 

 
• TroopMaster now tracks fundraisers at the unit and scout level, to include costs, payments, 

profits, etc. 
 

• Many new reports and lots of new report options. New reports include the Attendance Matrix, 
Target Eagle, Partial Merit Badges Progress Matrix, Eagle Application Assistance, Leadership 
History, Leadership Roster, Photo Directory, Physical Exam Status, Unit/Patrol Awards, and 
fundraiser reports. 

 
• Custom reports! Now you can select the fields you want to see on a report. 

 
• Any report can now be saved in HTML or Rich Text format. 

 
• Court of Honor report has been expanded to provide more flexibility. For example, the report can 

now be grouped by award. Also, there is now an option to print stick-on labels for merit badge 
and rank cards, saving you from having to fill out the cards by hand! 

 
• O/A Eligibility report is now much more flexible and informative.  
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• Individual History report is now totally flexible-design it yourself! 
  

• Complete user control of report formatting, including fonts, point sizes, and colors of the report 
sections (i.e., title, column headers, etc.). There is also a �paper saver� option that lets you fit 
more data on each page. In addition, you can now do duplex printing and/or select a page range 
to be printed. 

 
• All of the reports now �remember� the options you�ve selected, and those are automatically used 

as the defaults the next time you run the report. 
 

• Page Up/Down buttons are now active on displayed reports. You can also zoom in and out on 
your reports, and you can chose to display two pages at the same time. 

 
• When transferring a scout to the adult leaders file, you can now optionally transfer his 

attendance. Of course, the scout can still be archived at the same time. 
 

• When you archive a scout, TroopMaster now saves his attendance at specific activities so that it 
can be restored if he later returns to your unit. 

 
• Ability to transfer scouts between units that use TroopMaster ME. 

 
• We�ve added an Eagle Honor Roll so that you can save the names and Eagle completion dates on 

all of your Eagle scouts. New Eagle Scouts are automatically added to the honor roll but there is 
an option on the �Advancement� menu to let you enter the names of your other Eagle Scouts. 
There�s also an associated report. 

 
• A new �Unit Vehicle� field in case your unit owns a van or a bus. This vehicle can be selected 

for any driver on the Tour Permit Assistance report. 
 

• We�ve increased the number of scout and adult flags from three to five. On reports, you can now 
specify more than one flag per column. For example, you can choose to include scouts who have 
a Flag #2 of �S� or �C�. 

 
• New data fields and an associated report for medical information, such as emergency contact, 

physician, insurance information, etc. 
 

• TroopMaster now tracks the three levels of medical physicals separately, and there is an 
associated report that makes it easy to review each member�s status. 

 
• New dialogs and associated reports for unit and patrol awards. 

 
• Activities can now be assigned a �level�, such as �Troop�, �Crew� etc., so that each level can be 

reviewed separately, if desired. You can also review activities by type. 
 

• A new Attendance Matrix report for monitoring and/or recording attendance at activities. 
 

• TroopMaster now allows user-defined scout/adult leadership positions. 
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• The Partial Merit Badges dialog has been expanded to allow 15 badges, plus the program now 
allows you to track completion of the individual badge requirements. There is a new dialog that 
lets you define or change badge requirements when BSA releases a new badge or changes the 
requirements for an existing badge. 

 
• Navigation within the program is now easier and more flexible. Also, the Individual 

Advancement dialog has been simplified, and �Boy Scout� versus �Venturing� awards have been 
separated--radio buttons allow you to switch back and forth, as needed. �Special Awards� and 
�Training� have been removed from the list box and are now accessed through buttons on the 
Individual Advancement dialog and the Scout Management dialog. 

 
• User Preferences have been greatly expanded.  

 
• Many of the data fields, such as the last name fields, have been lengthened, and many new data 

fields have been added. 
 

• A new tab on the scout and adult leader personal data dialogs lets you define your own data 
fields and checkboxes. Of course, there are associated reports. 

 
• TroopMaster will now optionally print envelopes in addition to mailing labels. 

 
• Much more! Little surprises abound! 
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CHAPTER 1. INSTALLATION 
 
1.0 Overview 
 

The program CD in your package contains the TroopMaster ME setup program and the Users 
Manual. SETUP will create the necessary folders, install the software, and create an empty 
database. If you are upgrading, SETUP will convert the data from your previous version to 
the new database formats. 
 
You will need the following: 

 
(1) A 486 processor or higher with a minimum of 8 MB of RAM. 
 
(2) A hard disk drive with at least 10 MB of available disk space. If you also need to install 

Adobe Acrobat Reader 5.0, an additional 20 MB will be needed. 
 
(3) Windows 95/98/ME/2000 or newer 
 
(4) A printer supported by Windows. 

 
1.1 Registering Your Software 
 

During the installation, SETUP will ask you for a software registration code number. If you 
purchased the software directly from Troopmaster Software, your registration code number is 
on the sleeve that came with your program CD.  
 
If you purchased the software from your council office, you must register the software 
through TroopMaster Software to obtain a registration code number. You can install the 
software without a registration code number but if you do, you will be limited to 8 scouts and 
8 adults until you complete the registration process. Registration can be completed by email, 
by phone, or by returning the Software Registration Card. If you email us, please include all 
of the information from the Software Registration Card, including the software serial number 
from the top of the card. 

 
1.2 Installing TroopMaster ME 
 

SETUP will ask you to specify folders for your new software and data files. We recommend 
using the default folders but you can modify those, if desired. SETUP contains specific 
instructions for users upgrading from a previous version (see para. 1.3 below). 

 
We do not recommend using a removable media (e.g., zip drive) as the primary location for 
your data files. Removable media are not nearly as reliable as a hard drive. 

 
If you are upgrading, please do not install this new version in the same folder you used for 
the previous version. However, SETUP will ask you for the locations of the previous data 
and archive files so that it can convert your existing data to the new formats. SETUP will not 
overwrite or modify anything in your previous version. 
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To install TroopMaster ME, insert the program CD into your CD-ROM drive. The 
installation menu program should launch automatically. If it does not, follow the steps below: 

 
(1) Click the Start button and then select �Run�. 
 
(2) Click Browse and navigate to the SETUP.EXE file on the CD-ROM drive. 
 
(3) Click Open. 
 
(4) In the Run dialog box, click OK. 

 
Follow the instructions provided on the screen. When the installation is complete, remove the 
CD and store it in a safe place. 

 
The full Users Manual will be installed on your computer in PDF format. You must have 
Adobe Acrobat Reader 3.0 or newer installed on your computer in order to view the manual. 
In case you don�t have Acrobat Reader, SETUP will offer to install a copy. 

 
1.3 Upgrading from a Previous Version 
 

During the installation, SETUP will ask if you are a new user or upgrading. This information 
is necessary because if you are upgrading and your existing data is in a previous version 
format, it must be converted to the new TroopMaster ME database formats. However, if your 
data is already in the TroopMaster ME formats (i.e., you converted the data during a previous 
TroopMaster ME installation), follow the �Reinstalling� procedures below (see para. 1.5). 

 
1.4 Starting TroopMaster 
 

Click the Start button and select �Programs�. Highlight the TroopMaster Millennium folder 
and click the TroopMaster icon. 

 
1.5 Reinstalling TroopMaster 
 

If you previously installed TroopMaster ME and need to reinstall it or if you want to install it 
on a second computer, you�ll need a backup of the unit data files. This can be obtained using 
the File>Backup Data Files option. If you also want to load the archived data, you�ll need to 
perform a separate backup of the archive files. 
 
Run the installation as described above and select the �New User� option. When the 
installation is complete, start TroopMaster and select the File>Restore Data Files option. 
The active unit data and/or archived data can then be restored. 

 
1.6 Updating TroopMaster 
 

We occasionally make minor changes to the software and produce a program update (e.g., 
V2.01, V2.02, etc.). When we do, we post a free program update patch at the bottom of the 
TroopMaster product page on our web site. To see if you need an update, select the 
Help>About option to see which version of the software you are currently running. Then, 
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click the �Check for newer version� hyperlink at the bottom of the dialog, which will take 
you directly to the latest patch on our web site. Compare the version you have to the version 
of the patch. If your version is older, please download and install the update patch. For 
guidance on downloading and installing a patch, please see the FAQs page on our web site. 
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CHAPTER 2. USING TROOPMASTER ME  
 
2.0 Overview 
 

This chapter covers the �basics� you need to operate your new unit management system. 
TroopMaster is intuitive and very easy to use. However, reading this chapter first will get 
you started on the right foot. 

 
2.1 Main Menu 
 

There are ten main options on the Main Menu: File, Activities, Adults, Advancement, Flags, 
Fund Raisers, O/A, Reports, Scouts, and Unit. There is a separate chapter in the Users 
Manual corresponding to each of these options. Menu items can be selected with your mouse 
or by holding down the ALT key and pressing the letter underlined in the option name. 

 
2.2 Tool Bar 
 

A tool bar is available to provide faster access to the most frequently used features in 
TroopMaster. The following list identifies each of the tool bar buttons from left to right along 
with the equivalent menu path. 

 
Button      Icon Description    Menu Equivalent 

 
   Backup     Diskette with letter �B�  File>Backup Data Files 
 
   Restore     Diskette with letter �R�  File>Restore Data Files 
 
   Notepad     Hand with notepad   File>Notepad 
 
   Email      Letter and envelope   File>Send Email Message 
 
   Calendar     Wall calendar     File>Calendar 
 
   Adult Management  Man�s face      Adults>Adult Management 
 
   MBC Management  Citizenship in Nation MB  Adults>MBC Management 
 
   POC Management   Rolodex      Adults>POC Management 
 
   Activity Management  Camping tent     Activities>Activity Management 
 
   Fund Raisers    Dollar bill      Fund Raisers>Sales & Payments 
 
   Advancement    Fleur-de-lis     Advancement>Individual Scout 
 
   Scout Management  Boy�s face      Scouts>Scout Management 
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2.3 Backups 
 

Backing up your unit data files is extremely important because this data represents a major 
investment of your time. Don't let a hard drive failure force you to reenter everything from 
scratch. Please see Chapter 14 for recommended procedures.  

 
The File>Backup Data Files option in conjunction with the File>Restore Data Files 
option can be used to transfer the unit database and/or archive files from one computer 
to another. However, all of the unit�s data on the target machine will be overwritten by 
the data restore option. If you plan to merge data files, you must use the distributed 
database management feature (see para. 3.12). 

 
2.4 System Date 
 

TroopMaster gets the date from your system clock and uses it extensively throughout the 
program. The date is especially important to the automatic crediting functions. Please ensure 
your system date is correct before starting TroopMaster. 

 
2.5 Data Entry Windows Dialogs 
 

The cursor can be positioned to or within any data entry field with your mouse. Press TAB to 
move to the next data entry field or Shift-TAB to move to the previous field. Pressing 
ENTER activates the highlighted button. 

 
Please do not make data entries with Caps Lock on. Doing so makes it very difficult for 
TroopMaster to fit your entries on displays and reports. Even worse, it can cause ScoutNET 
processing of your council reports to fail. 

 
To facilitate collecting data on your scouts and adult leaders, several data collection forms 
are available. There are personal data collection forms for your scouts, adults, merit badge 
counselors, and points of contact as well as an advancement data collection form for your 
scouts. Copies of these can be printed through the Reports>Forms option. 

 
The File>Preferences option has fields for you to enter the city, state, zip code, and area 
code common to most of your scouts and adults. Your entries here will be used as the 
defaults whenever you add a new scout or adult to the database. 

 
Most items on the various data entry dialogs are self-explanatory. For others, holding the 
mouse pointer over the field label will display an expanded description. 

 
2.6 Dates 
 

Dates can be entered in a variety of formats using slashes, dashes, or periods as separators or 
by typing a six-digit date with no separators. The following entries are equivalent: 09/06/01, 
9/6/01, 9.6.01, 9-6-01 and 090601. If you omit the year (e.g., 9/6), TroopMaster will 
automatically append the current year. Please do not enter 4-digit years. TroopMaster 
internally appends the century based on context logic. 
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In addition, some date fields (mostly in the advancement area) allow special entries. This is 
done by typing a single character in the first position of the date field: 

 
a. Complete. Enter a C. Available only in the O/A and scout advancement areas, this is used 

to show completion of a requirement when no specific date is available. 
 
b. N/A. Enter an N. Available only in the scout advancement area, this is used to mark a 

new requirement that BSA added after the scout completed that rank. 
 
c. Old Rules. Enter an O. Available only in the scout advancement area, this option can be 

entered for any item under 1st Class and below. If a scout completed a rank under the old 
Skill Awards (pre-1989), use this option to mark completion of the newer requirements. 

 
d. Same Date. Enter an L or S. TroopMaster will repeat the last date entered. 
 
e. Today's Date. Enter a T. This option is available in all date fields. 
 
f. Transfer. Enter an X. Available only in the O/A and scout advancement areas, this option 

is used to show that a scout completed a requirement with his previous unit and you don�t 
know the exact date. 

 
g. Waived. Enter a W. This option can only be used for some of the 2nd/1st Class 

swimming requirements. 
 

Actual dates (M/D/Y) are required for awards, merit badges, and Boards of Review. 
 

There is also a pop-up menu to assist you in date entry. Simply right-click the date field and 
you can then choose to copy/paste a date or to select a specific date from a pop-up calendar. 

 
2.7 Modifying Date Entries 
 

To change the completion date on an award, merit badge, or training course that has been 
added to a list box, double-click the entry and enter the new date in the pop-up window. 

 
2.8 Saving Changes 
 

Clicking the OK button always saves data entries. Click Cancel to exit a data entry dialog 
without saving your changes. 

 
2.9 List Box Selection 
 

a. Single Selection. In addition to highlighting the desired item and clicking OK or Select, 
single-selection list boxes allow you to simply double-click the item. Double-clicking 
will immediately execute the request unless additional information is needed.  

 
b. Multiple Selection. Some (but not all) list boxes allow you to make multiple selections. 

For example, when crediting group advancement, you can select multiple names from the 
list of scouts. To select more than one item from a list box, hold the CTRL key down 
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while you click the desired items with the mouse. To select a contiguous group of items, 
click on the first item desired; then, hold the SHIFT key down and click the last desired 
item in the group.  

 
You can distinguish multiple selection list boxes by the field label. For example, if more than 
one activity type can be selected, the label will say, �Select type(s)�. 

 
One way to move quickly to the desired point in a long list of entries is to move the focus to 
the list box and then start typing the name of the desired item. For example, type WH while 
the focus is on a list of merit badges to move directly to �Whitewater�. 

 
2.10 Quick Access Buttons 
 

Numerous dialogs include quick access buttons that enable you to move quickly to related 
dialogs. For example, when on an adult�s personal data dialog, quick access buttons let you 
to jump to the adult�s training, awards, or leadership dialogs. 

 
2.11 Family Links 
 

All of the scout and adult personal data dialogs have �link� options that let you link family 
members together. Once this is done, all common data items between the records will be 
updated whenever any record is updated. Because it is very important that you understand 
how these work, we strongly recommend that you read Chapter 15. 
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CHAPTER 3. FILE 
 
3.0 Overview 
 

This menu provides a group of miscellaneous utilities. It includes such things as file 
backup/restore, data import/export, database management, and archive access. 

 
3.1 Backup Data Files 
 

This option allows you to backup your active database and/or your archived data. Select the 
file type to backup and then enter a backup location. You can backup to diskette(s), to a zip 
cartridge, or to another directory on your hard drive. Either enter a destination path or use the 
Browse button to select a backup location. 

 
TroopMaster will compress your data files into a single, small backup file. Optionally, it will 
attempt to do the same with your scout/adult photos. However, photos do not compress as 
well as data so they require a lot more space. If your photos backup will not fit on a floppy 
diskette, you will need to use a larger medium, such as a zip cartridge. 

 
3.2 Open Archive Files 
 

To review your archive or to print a report on a scout or adult who has been archived, select 
this option. Since it�s possible to have more than one archive, TroopMaster will ask you to 
specify the path to your current archive. The default path will automatically display the last 
archive used. TroopMaster will then load your archived files and change the window title to 
remind you that you are in the archive. Options not available in the archive (e.g., 
File>Activities) are deactivated. See Chapter 13 for more information on using the archive. 
 
The menu option name will change to �Open Active Unit Data.� When you have finished 
reviewing your archive, select this option to switch back to your active unit. 

 
3.3 Restore Data Files 
 

This option enables you to restore data from a backup made through the data backup feature 
described in paragraph 3.1 above. It will also restore data from a manual backup if all of the 
data files are on one medium. You can elect to restore your active unit data or your archive. 
If restoring from a manual backup (i.e., the backup was not made from within TroopMaster), 
please turn off the �Decompress files� checkbox. 
 
Check �Restore text files� to restore any Notepad files that are on the backup. If you want to 
restore the flag settings (see Chapter 9) for your scouts and adults, check that box. 
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�Restoring� data is a critical operation. If the backup medium is damaged, that damage 
could be transferred to the files on your hard drive, making those unusable. Before 
restoring a set of data files, you should backup the existing data files on your hard drive 
to a different diskette or directory. This will allow you to recover if the restore fails or if 
the restored data is damaged. 

 
3.4 Email Data Files 
 

If more than one unit leader is using the software, you will need to periodically provide 
database updates to the other leaders. The File>Email Data Files option makes it easy to 
email the files so that you don�t need to hand deliver them on diskette. Simply select the 
desired recipient(s) and click Send. 
 
TroopMaster will compress your database into a single, small backup file, attach that to the 
message, and post the message in your email system�s �Outbox�. The recipient will need to 
save the message attachment to a diskette or hard drive folder, and then load the backed up 
files via the File>Restore Data Files option. 

 
If you are using the distributed database feature (see para. 3.12), please do not use this 
option to send data from a master to a satellite system. Instead, email satellite files 
through the File>Database Management option. 

 
3.5 Send Email Message 
 

There are many ways to initiate email from within TroopMaster. For example, you can select 
this menu option, click the email tool bar button, or you can choose to email a report.  

 
You then need to select the desired recipient(s) for your message. First, click the �Display� 
drop-down list to choose the desired group (i.e., scouts, adults, parents, etc.) From each 
group, highlight the recipient names and then click To or CC to add the selected names to the 
primary addressee (i.e., �To�) list or the carbon copy (�CC�) list. You can select names from 
as many of the different groups as you like. If you need to email someone who is not in the 
database, enter that email address in the �Other� field. To remove a recipient that was added 
in error, highlight the name and click Remove. 
 
Enter the subject of your message in the field provided. TroopMaster provides a limited 
�Body� field where you can enter text for your message. However, your email system 
provides a much larger text field as well as extensive editing and formatting options. To take 
advantage of those features, click the �Display message prior to sending� checkbox. Then, 
when you click Send, TroopMaster will activate your email system, which will display your 
new message. This gives you a chance to expand and polish your message before it is 
transmitted. 

 
Use of the email features in TroopMaster requires a MAPI compliant email system that uses 
the SMTP protocol. 
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Some email systems have a security feature that warns you if another program (such as 
TroopMaster) adds a message to your �Outbox�. You may get this warning if you did not 
check the �Display message prior to sending� checkbox. As of this writing, there is no way to 
deactivate these warnings. 

 
Often, there will be a specific group of people to whom you send messages on a regular 
basis. Because of that, TroopMaster provides a Save Recipient Group button. If you want to 
save a selected group of recipients so that you can use the group again later, add all of the 
desired names to the �To� and �CC� lists, and then click this button. Then, enter a unique 
group name and click OK. Recipient groups that you have defined are available through the 
�Display� drop-down list. To delete a recipient group, select it from the drop-down list and 
click the Delete Recipient Group button. 

 
You can also send an email message to an individual recipient by clicking the �Email� button 
next to the member�s email address or by right-clicking within any email edit box in the 
system. 

 
3.6 Export Data Files 
 

Many people like to design custom reports or to use unit data for other purposes. For 
example, having access to the scouts' names and addresses could allow you to create 
mail/merge documents with your word processor. 

 
To facilitate that, TroopMaster allows you to export data from virtually any area of the 
database. The data is written to delimited ASCII files using any delimiter you choose. Most 
of the time you will want to import the data into a database management system or 
spreadsheet so that you can manipulate the data, design reports, etc. 
 
The default delimiter is a comma but you can change that to any character desired. To create 
TAB delimited files, enter T. If you would like to have the names of the data items you select 
to appear in the first line of the export file, check the associated checkbox. If you will be 
exporting dates, select the desired format.  
 
Then, select the area (e.g., scout data, adult data, activities, etc.) of the database from which 
you want to export data. TroopMaster will display a list of data items from that area in the 
�Available Fields� list box. You can then select the specific data items you want and add 
them to the �Fields to Export� list box. To do that, highlight the desired fields and click Add. 
If you want all of the data items, click Add All. To remove an item that was added in error, 
highlight the item and click Remove.  

 
When you have finished selecting all of the desired data items, review the order of the items 
in the �Fields to Export� list. This is the sequence order in which these fields will appear in 
the export file. If you need to change the sequence, highlight the field that needs to be 
relocated and click the Move Up or Move Down button. 

 
a. Filtering Activities. If you are exporting activity data, you can optionally limit the export 

file to a specific activity type. If you want all activity types, select that option from the 
drop-down list. If you only want activities that fall within a desired time period, enter the 
desired �Start-End� dates. 
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b. Filtering Scouts/Adults. If you are exporting scout or adult data and you wish to limit the 
export to specific group of members, use the �flags� options at the top of this dialog. For 
more information on the use of flags, see Chapter 9. 

 
You are now ready to create the export file. If you wish to view and/or print a copy of the file 
format, click the View Export File button. When finished, click the Export button. 
TroopMaster will display a Save As dialog that allows you name the file and select the target 
folder. 

 
3.7 Import 
 

TroopMaster will import data from any of our other software packages. You can also import 
from an ASCII delimited file or a ScoutNET export file. 

 
a. ASCII Delimited. This option makes it possible to import data that you were maintaining 

on some other database system. You�ll need to export the data from the other system to 
an ASCII delimited text file. You can use any delimiter you like.  

 
We recommend that you first create an import format structure in TroopMaster and then 
use that format when creating the export file from your other program. First, select the 
type of data you plan to import from the �Select area� drop-down list. Then, highlight the 
desired data items and click Add. If you add a field by mistake, highlight it and click 
remove. If necessary, adjust the data item sequence by highlighting the item that need to 
be moved and click the Move Up or Move Down button. When finished, click the View 
Import Format button and print a copy of the file format. Use this along with the 
delimiter you selected to create your import file. 
 
When you have the file, return to this dialog, recreate the same import structure, and click 
Continue. Lastly, browse to the import file and click Open to begin the import process. 

 
If you are importing personal data on scouts, adults, merit badge counselors, or POCs, 
the members being imported will be added as new members to the database. If you are 
importing other data on scouts and adults (e.g., merit badges, special awards, training, 
etc.), then for each member in the import file, TroopMaster will look for a name match 
in the existing database; if it finds one, it will add the new data to that person�s records. 

 
b. Cub Scouts from PackMaster. This option lets you import scouts who are graduating 

from a Cub Scout pack that is using the PackMaster program from Troopmaster 
Software, Inc. The pack representative should give you a transfer diskette containing the 
graduating scouts and, optionally, adults. The import feature will add the new scouts and 
adults to your troop and transfer their personal data. If earned, Arrow of Light will be 
added to each scout's special awards file. 

 
You cannot import from a backup of the PackMaster database. The pack leader must use the 
PackMaster Graduate to Boy Scouts option. 

 
This same feature is accessible through the Scouts>Receive Cub Scouts option. 
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c. MBCounselors. This option lets you import merit badge counselors from an export file 
created by a district leader who is using the MBCounselors program from Troopmaster 
Software, Inc. The district leader must have created the file through the MBCounselors 
File>Export feature. Also, he must have selected the �Export badges by number� option. 
If you want to replace the counselors you currently have in the database with the ones in 
the export file, check the �Delete all existing counselors before importing� checkbox. 
Otherwise, the new counselors will be added to the ones already in your database. 

 
d. ScoutNET. TroopMaster can import scout and adult personal data from an export file 

created by your local council using the BSA ScoutNET computer system. Council 
personnel procedures are as follows: 
 
1) From the ScoutNET main menu, select the "Unit Menu". 
2) Do a unit search. 
3) Insert a diskette and click the "Export" button.  
4) Go to the print queue screen and select "Save to disk". 
5) Lastly, select "Save all files" (not "Save print files"). 

  
If that's done correctly, the name of the file they'll give you is "LODxxxxx.CSV", where 
xxxxx denotes your unit type and number. Our Import from ScoutNET feature will import 
from that, which will save you from having to start with an empty database. 
 
This procedure will add the scouts and adults in the export file to your database. You cannot 
use this procedure to update existing scouts and adults. As of this writing, only a limited 
amount of personal data is imported. The ScoutNET file does not contain advancement data. 

 
e. TroopLedger. This option is provided in case your unit started with TroopLedger and you 

want to transfer the data on scouts and adults from that program. This is a one-time 
operation. The data to be imported must have been created through the TroopLedger 
File>Transfer option. 

 
Any scouts or adult members you may have already entered will be overwritten by the 
import. 

 
If your unit uses both programs, TroopMaster is considered the �master� database. 
Accordingly, new scouts/adults and updated personal data are normally imported into 
TroopLedger from TroopMaster.  

 
3.8 Calendar 
 

This option provides the electronic equivalent of a wall calendar. You can access it through 
the menu option or the tool bar button, and you can display anywhere from one to 12 months 
at a time. Use the arrow buttons to view future or past time periods. 
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3.9 Notepad 
 

Often you need to make notes of �things to do� or for many other purposes. This option 
provides rapid access to the Windows Notepad. A �TroopMaster Notes� file has already been 
created for you. You can use that or you can create as many others as you like. Notes you 
create can be edited and printed. See your Windows documentation for more information on 
Notepad. 

 
3.10 Create New Archive 
 

The archive created during program installation will store up to 250 scouts and 250 adult 
members. If that fills up, use this option to create a new archive.  

 
3.11 Create TroopLedger Import Files 
 

TroopLedger cannot import data directly from the TroopMaster ME database so you must 
use this option to create a set of data transfer files. These can be created on a diskette, a zip 
cartridge, hard drive folder, etc. To complete the data transfer, start TroopLedger, select the 
File>Import option, and point it to the location where you saved these files. 

 
3.12 Database Management 
 

TroopMaster allows you to divide your database into as many as eight different functional 
areas so that different leaders can be assigned responsibility for updating specific area(s). 
This is accomplished by defining �profiles� for the different leaders. Once these are defined, 
you can distribute the data profiles to selected leaders creating what are called �Satellite 
Systems�. Each satellite has �view� access to the entire database but each leader can only 
update his assigned area(s). On dialogs where update authorization is denied, the OK button 
is deactivated and the button text is changed to Locked. 
 
The central database is called the �Master� system. The leader responsible for the master 
system is the database manager and s/he is the only person allowed to: 

 
(1) Add/delete people (scouts, adults, counselors, etc.) to/from the system. 
(2) Define patrols and make patrol assignments. 
(3) Define, distribute, and merge satellite profiles. 
(4) Make entries on the Unit General Information dialog. 

 
The database manager can also update any functional area that has not been distributed to a 
satellite.  

 
If you modify the profile name or settings for a specific satellite while that satellite is 
distributed, you will no longer be able to merge data from that satellite. 

 
Because of the internal links between the various data files, the database manager 
cannot add/delete people to/from the system while any profiles are distributed. 
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a. Defining a Profile. To define a profile, enter a profile name and select the functional 
area(s) you wish to assign to that satellite. The available areas are as follows: 

 
(1) Activities (including scout/adult attendance)  
(2) Advancement (including scout training and special awards) 
(3) Fundraisers 
(4) Order of the Arrow (scout and adult) 
(5) Adult Members (including training, special awards, and leadership) 
(6) Merit Badge Counselors 
(7) Points of Contact 
(8) Scout Membership (i.e., personal/parental data, vehicles, leadership, etc.) 

 
To create a �read only� copy of the database, define a satellite profile that has no functional 
area authorizations. The satellite will be able to view any of the data and print any of the 
reports, but will not be able to make any changes.. 

 
If you are using the family links, you must take care when defining your satellite 
profiles. These links provide a way to tie family members together between four of the 
functional areas: scouts (and parents), adult members, merit badge counselors and 
points of contact. Since these four areas are �linked�, you must assign all four areas to 
the master system or to a single satellite. If you decide to divide responsibility for these 
areas among two or more leaders, you must first disable the family links. The Database 
Management dialog has a radio button that allows you to do that. 

 
b. Distributing a Profile. There are two ways to distribute data files to a satellite. Select the 

desired profile from the drop-down list. Then, do one of the following: 
 

(1) Path. Enter a location to which to send the satellite files. The files can be sent to any 
location desired. If you plan to give a diskette to the satellite, enter A: as the 
distribution location. TroopMaster will remember the location you enter and use that 
as the default the next time you distribute or merge this profile. 

 
(2) Email. To email the files, click this button and then select the desired recipient from 

the drop-down list of adult members. 
 

When ready, click the Distribute Files button. TroopMaster will compress the data files 
into a single, small backup file. If you entered a path, TroopMaster will save the backup 
file to the specified location. If you chose the email option, TroopMaster will attach the 
backup file to a new message and bring up the Send Email dialog. If you like, you can 
add other recipients before you click the Send button. 

 
Each satellite must already have installed the TroopMaster program. SETUP always creates a 
master system. To convert the system to a satellite system, the satellite user selects the 
File>Restore Data Files option and enters the location of the compressed satellite backup 
file given to him by the database manager. If the file was emailed to the satellite user, he 
must use his email system to save the message attachment to a diskette or hard drive folder; 
s/he then restores the data from that location. 
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c. Merging a Profile. When you are ready to update the master database, have each of the 
users with a satellite system give you a backup of his database. This can be accomplished 
via either the File>Backup Data Files option or the File>Email Data Files option. Each 
profile must be merged separately. To do that, select the profile name from the drop-
down list, enter the location of the satellite files, and click the Merge Files button. 
TroopMaster will read the source files and merge that data with the other data in the 
master database. 

 
Whenever a satellite user provides a database backup to the master system for merging, 
the satellite user must refrain from making any changes to his database until after s/he 
has received and loaded a new set of distributed data files from the master system. 
Otherwise, when s/he loads the newly distributed files, s/he will overwrite his recent 
changes. 

 
Merging data files is a very complex procedure and the potential for error exists. For 
example, one or more of the source files could be damaged or unreadable. If that is the 
case, the merge process will almost certainly corrupt your master database. For this 
reason, it is critical that you backup your master database before merging any profiles. 
We recommend maintaining at least two backups of your master database. 

 
The database manager should never attempt to merge data from a satellite using the 
File>Restore Data Files option. Doing so will convert the master system into a satellite. 

 
3.13 Preferences 
 

This dialog is used to adjust system-wide settings and to customize TroopMaster to your 
personal preferences. The dialog has four tabs: 

 
a. Default Settings. This tab lets you set default values for city, state, zip code, area code, 

and phone types. Setting these values will save you time whenever you add new scouts 
and adults to the system. If you are operating in a foreign country that does not use U.S. 
formatted zip codes and phone numbers, you should de-select the �U.S. phone/zip 
format� checkbox. TroopMaster processes overseas addresses, zip codes, and phone 
numbers differently than it does for stateside units. A list of countries and associated 
country codes is available through the Help button. 

 
This tab also has several button and checkbox options: 

 
(1) Display �Tip of the Day� on Startup. When you no longer want to see these tips, turn 

this off. 
 
(2) Save Location of Report Display Window. If this box is checked, TroopMaster 

remembers the size and location of the last report window displayed and uses those 
settings as defaults for the next report. If this box is unchecked, TroopMaster will 
bring up the report display window using the same location/size as the main 
application window. 
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(3) Prompt for Data Backup on Program Exit. Because backing up your database is so 
important, TroopMaster will offer to perform a backup each time you exit the 
program. This turns the backup prompt off. 

 
(4) Use Formal Name on Lists/Reports. TroopMaster always uses scout and adult formal 

names instead of nicknames on ScoutNET related reports. Check this option if you 
want the program to use formal names on all reports. 

 
(5) Print Flag Setting on Reports. Check this box if you want your selected flag options 

included on reports. Please see Chapter 9 for more information on the use of flags. 
 
(6) Include Area Code on Reports. If all of your scouts and adults share the same area 

code, you may want to turn this option off. 
 
(7) U.S. Phone/Zip Format. If you unit is outside of the U.S. but still uses U.S. formats, 

check this box. 
 
(8) System Password. Click this button if you want to password protect your system. 

Then, enter a password of 4-8 characters. You will be asked to reenter the password a 
second time to confirm your entry. To clear a password, erase both entries and click 
OK. 

 
If you forget your password, please contact Troopmaster Software. 

 
b. Background. This tab lets you adjust your main menu background colors. You can also 

replace our camping scene bitmap, if desired. 
 
c. Page Settings. This tab lets you adjust margin settings for reports and labels. You can 

also modify the label settings to accommodate any size labels. Separate settings are 
available for mailing labels and award cards (see para. 12.3c for more information on 
award cards). There is a Restore Defaults button in case you get yourself into trouble. If 
you want to increase the number of lines printed on each page, adjust the �Paper Saver� 
setting. In addition, there is a �Duplex Printing� option in case you want to print on both 
sides of the paper. TroopMaster can do this even if you don�t have a full duplex printer. 

 
d. Report Fonts. This tab lets you choose a font, style, point size, and color for each section 

of the reports. Just click the button for the section you wish to change. 
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3.14 Repair Database 
 

You will probably never need this option but it is available, just in case. The option will 
rebuild your index files and examine your other data files. If missing records are found, they 
will be replaced with blank records. TroopMaster will report any errors it finds. However, the 
repairs that can be made are very limited. If a file has been overwritten by �garbage�, the 
repair process will not be able to fix it. 

 
Before running this option, backup your existing data. Do not overwrite any previous 
backups. A backup will be needed if the repair process fails. 

 
This option is an emergency procedure. If your database is damaged, your best option 
is to restore your data files from a good backup. 
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CHAPTER 4. UNIT 
 
4.0 Overview 
 

This area allows you to enter the basic information on your unit (e.g., address, sponsor, 
meeting place, etc.). This is also where you define your patrol names, and make scout 
leadership and patrol assignments. 

 
4.1 Unit General Information 
 

This information is needed by TroopMaster to generate the Annual Recharter report, the Unit 
Advancement Report (4403), and your unit return address labels. ScoutNET-required data 
fields are marked with an asterisk. Most of the fields are self-explanatory. A brief description 
of the other areas follows: 

 
a. Unit/Level. If your unit is not a Boy Scout Troop, select the correct level. If your unit 

operates under the auspices of the Church of Jesus Christ of Latter-Day Saints, check the 
�LDS� checkbox and TroopMaster will apply the special LDS rules when it validates 
your annual recharter report. 

 
b. Council/District. Enter your council name and number (#) and also the name of your 

district. 
 
c. Website. If your unit has a website, enter the URL. Clicking the �Website� button will 

then take you directly to your site. 
 
d. Special Needs. If yours is a �special needs� unit, select the appropriate type and click the 

Description button to provide details. 
 
e. Meeting Place. Enter the name, address and phone number of your unit�s primary 

meeting location and phone number. 
 
f. Vehicle. If you have a unit vehicle, enter the details here and TroopMaster will make that 

vehicle one of the options on the Tour Permit Assistance report. 
 
g. Mail Recipient. This information is used by TroopMaster to produce your return address 

labels. Your unit type/number (e.g., �Troop 123�) will automatically be included on the 
labels, so you don�t need to enter that. 

 
h. Original Charter/Expiration. Enter the date on which your unit was originally chartered 

and the date that your current charter expires. 
 
i. Chartered Organization. Enter the name, address and phone number of your chartered 

organization. 
 

A remarks field is available to record information for which there is no specific field. Entries 
in this field will not be included in the recharter report. 
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If you wish to include a photo of your unit, click the Unit Photo button. This photo will be 
printed on the Unit General Information report. 

 
4.2 Patrol Assignments 
 

This option lets you set or change your patrol assignments. The �List currently displays� 
drop-down box allows you to display the names of all scouts in the unit or just those in a 
specific patrol. The are several ways to assign scouts to patrols: 

 
(1) Highlight the names of one or more scouts, highlight the desired patrol, and click the 

Assign button. 
 
(2) Highlight the names of one or more scouts and double-click the desired patrol. 
 
(3) Highlight the desired patrol and double-click the names of the scouts being assigned to 

that patrol. 
 
4.3 Patrol Names 
 

This display lets you define up to 24 patrols. Patrols will always be printed on reports in the 
same order as listed on this dialog. Since you may be adding more patrols later, you may 
wish to space out your entries accordingly. 

 
TroopMaster internally stores each scout�s patrol assignment by number, not by name. 
Therefore, if you rearrange the patrols on this dialog, you must also reassign your scouts 
through the Patrol Assignments dialog. 

 
4.4 Patrol Awards 
 

This option lets you credit awards for any of your patrols. Select the desired patrol and for 
each award, enter an award name and completion date; then, click Add. To remove an 
erroneous award, highlight it and click Remove. 

 
4.5 Unit Awards 
 

This option lets you credit unit awards. For each award, enter an award name and completion 
date; then, click Add. To remove an erroneous award, highlight it and click Remove. 
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CHAPTER 5. SCOUTS 
 
5.0 Overview 
 

In addition to adding and deleting scouts from your unit, this area lets you enter, review, and 
edit information on your scouts, such as personal data and patrol/leadership assignments. 
Other options include school grade promotion, archive and retrieval from archive, and import 
of graduating Cub Scouts. 

  
5.1 Scout Management 
 

As the name implies, this option allows you to add new scouts to the unit and to review/edit 
virtually any of the data on existing scouts. Use the Add New button to add new scouts to 
your unit and the Personal Data button to edit/review personal data on existing scouts. Both 
buttons will take you to the same tabbed personal data dialog. Additional buttons let you 
access the other areas of each scout�s records. If you need to delete or archive a scout, use the 
Del/Archive button on the scout personal data dialog. 

 
a. Personal Data. Most data fields are self-explanatory. Fields marked with asterisks are 

required for the BSA ScoutNET reports (see para. 12.9f). A brief description of each tab 
follows. 

 
(1) Personal #1. In addition to name and address, this tab has fields for date of birth 

(DOB), social security number (SSN), school grade and Cub history. A separate 
mailing address field is available if the scout's mailing address is different from his 
street address. If you want to attach a photo of the scout, click the Photo button and 
browse to the appropriate JPG, GIF, or BMP file. 

 
Many units have requested the addition of social security number fields, but collecting 
SSN�s raises Privacy Act issues. You may wish to consult an attorney before doing so. 

 
The scout�s formal first name will be used on reports that go to council, but normally his 
nickname will be used on all other displays and reports. If desired, you can choose to use 
formal name throughout the program-see the File>Preferences option.  

 
The �Joined Unit� date is used when TroopMaster computes attendance percentages and also 
in conjunction with the scout�s �Prior Service� when computing service stars. If the scout has 
had breaks in service, enter the date he began his current service here and enter periods of 
prior service on the �Prior Service� tab. TroopMaster includes completed service stars on the 
Court of Honor report. 

 
If all or most of your scouts have the same city, state, area code, etc., enter those on the 
Preferences dialog and TroopMaster will use your entries as the defaults. 

 
To email a scout, just click the button next to his email address. 
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(2) Personal #2. This tab lets you record medical information including the last date for 
each class of physical exam. The �Special Needs� field is there in case the scout has a 
special condition that should be recorded. If so, you should click the Description 
button to more fully describe the condition. Tour permit information can be entered 
on two family vehicles.  

 
Special needs codes and the corresponding descriptions are included in your annual 
recharter report for ScoutNET. 

 
(3) Parents. ScoutNET-required fields are marked with asterisks but you need only enter 

data on one parent. If the parent is going to be an adult leader, merit badge counselor, 
and/or a POC, use the �links� to create record(s) in the associated area(s). Please see 
Chapter 15 for more information on family links.  

 
Many units have requested the addition of social security number fields, but collecting 
SSN�s raises Privacy Act issues. You may wish to consult an attorney before doing so. 

 
You must enter data in all of the required fields for at least one parent. Parents who have data 
entries in all of the required fields will be included in the Council Recharter report. 

 
(4) Alt Relative Data. This tab allows entry of information on an additional relative or 

other adult when needed due to divorce, separation, etc. Inclusion of alternate relative 
information is an option on several reports. 

 
(5) Prior Service. If the scout has had breaks in service, enter the �From-To� dates of the 

scout's prior service and the associated levels, unit numbers, and council numbers. 
Cub Scout service should be entered on the �Personal #1� tab. Entries here will be 
added to current service when computing service stars. 

 
(6) Remarks/Other. This tab provides a place for you to enter information for which there 

are no pre-defined data fields. In addition to a remarks field, there are eight user-
defined fields: four text fields and four checkboxes. You can enter your own label for 
any of these fields by clicking the existing label and then entering a new label. For 
example, you might redefine one of the text field labels as �School� or use one of the 
checkboxes to indicate �Fees Paid�. Whatever field labels you enter for any scout will 
be used for all of your scouts. TroopMaster has a special report for the user-defined 
data fields. 

 
When you click OK, TroopMaster will save your data entries.  
 
If you are in the �Add� mode, TroopMaster will present a pop-up list of your patrols so that 
you can assign the new scout to a patrol, if desired. When you close the Patrol Assignments 
dialog, TroopMaster will clear the scout entry dialog so that you can add another scout, if 
desired. Since city, state, and zip code are often the same or similar for all scouts in a unit 
those fields will not be cleared. Click Cancel when you have finished adding scouts. 

 
If you are entering the brother of another scout in your unit, use the Link Sibling button to 
link the scout to his brother. Please see Chapter 15 for more information on family links.  
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If you are in �Edit� mode, several additional buttons are available. Quick access buttons will 
take you directly to the Patrol Assignments dialog or to the advancement, training, or 
leadership assignment dialogs for the scout being displayed. Previous and Next buttons 
enable you to page to the next or previous scout in the personal data files. 

 
Note that when you click the Next or Previous buttons, TroopMaster leaves you on the same 
tab. This provides a powerful method of reviewing and editing data on your scouts. For 
example, to review medical information, go to the �Personal #2� tab for the first scout, make 
any desired changes, and then click Next to move to the next scout. 

 
To archive or delete a scout, click the Del/Archive button on the tabbed dialog. A pop-up 
window gives you the option of archiving the scout before he is deleted.  

 
If you delete or archive a scout who is over 17, you will be given the option of creating a 
record for him in the adults file. 

 
b. Advancement. This button will take you to the selected scout�s Individual Advancement 

dialog. Please see Chapter 6 for more information on entering advancement data. 
 
c. Special Awards. Click this button to enter or review the scout�s special awards. These are 

also covered in Chapter 6. 
 
d. Leadership. This dialog handles the scout�s current leadership position(s) as well as any 

previous positions in which he has served.  
 

(1) Current Positions. To assign a scout to a position, select it from the drop-down list 
containing a menu of defined leadership positions. If you need to assign the scout to a 
position that is not on the menu, click the Define Positions button and add it. You can 
assign two current leadership positions to each scout. To remove a scout from a 
previously entered position, select the blank position from the drop-down list and 
enter the date he vacated the position. The first position has a �Credit toward 
leadership requirement� checkbox. The default value is taken from the setting on the 
Define Leadership dialog. 

 
TroopMaster monitors and automatically credits the �Position of Responsibility� 
requirements for Star, Life, and Eagle (see Appendix B). In doing so, only the first 
leadership position is considered. Therefore, if you assign two positions to a scout, you 
should use the more important of the two for the first position.  

 
Suppose that a scout is assigned to a position but is not doing a good job and you don�t want 
him to get any credit for the �Position of Responsibility� requirement. If you turn the 
�Credit� checkbox off, TroopMaster will not apply the position toward automatic credit.  

 
When a scout changes leadership positions, the vacated position is automatically moved to 
his leadership history list. The �Effective Date� of the new position is used as the closeout 
date of the old position.  
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(2) Leadership History. This area allows you to enter previous positions (maximum 15) 
in which the scout served. To add a position to the list, select it from the drop-down 
menu and enter the �From-To� dates. If the position was creditable toward the 
�Position of Responsibility� requirement, check the �Credit toward leadership 
requirement� checkbox. Then, click Add. To remove a position from the list, 
highlight the position and click Remove. 

 
A scout's leadership history is included on his Individual History report. If a scout serves in 
more than 15 positions, the oldest one is dropped when a new one is added to this list. 

 
In computing automatic credit of the �Position of Responsibility� requirement, 
TroopMaster considers the scout�s current position #1 plus the creditable positions on 
his leadership history list. Remember that only positions that he has held since his 
previous promotion are counted toward completion of this requirement for his next 
rank. Valid positions for each rank are listed in the Scout Handbook. 

 
e. Order of the Arrow (O/A). Click this button to enter or review O/A data on the selected 

scout. See Chapter 11 for more information. 
 

f. Patrol. Click this button to go to the Patrol Assignments dialog. 
 

g. Training. Click this button to enter or review training courses for the selected scout. For 
more information on scout training, see Chapter 6. 

 
5.2 Define Leadership 
 

Use this dialog to add leadership positions to the list of system-defined positions. Positions 
listed here will appear in the drop-down menu presented whenever you assign a scout to a 
position. To define a new position, enter a position name and if it will usually be counted 
toward the �Position of Responsibility� requirements, click the �Credit� checkbox. Then, 
click Add. 

 
5.3 Define Special Awards 
 

Use this dialog to define the scout special awards commonly presented by your unit. These 
entries will appear on an awards menu that is presented whenever you credit a scout with an 
award. However, you can credit scouts with awards that are not on the menu by using the 
�Other� option (see para. 6.13). 

 
5.4 Define Training 
 

Use this dialog to define the training courses commonly attended by your scouts. These 
entries will appear on a course menu that is presented whenever you credit a scout with 
completing a course. However, you can credit scouts with courses that are not on the menu 
by using the �Other� option (see para. 6.14). 
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5.5 Promote to Next Grade 
 

The scout personal data includes a �Grade� field. At the end of the school year, you can 
promote all of the scouts in the unit through this dialog.  

 
5.6 Retrieve from Archive 
 

If a scout you archived later returns to your unit, you can retrieve his data through this 
option. See Chapter 13 for more information on use of the archive. 

 
5.7 Receive Cub Scouts from PackMaster 
 

This option lets you import scouts who are graduating from a Cub Scout pack that is using 
the PackMaster program from Troopmaster Software, Inc. The pack representative should 
give you a transfer diskette containing the graduating scouts and, optionally, adults. The 
import feature will add the new scouts and adults to your unit and transfer their personal data. 
If earned, Arrow of Light will be added to each scout's special awards file.  

 
You cannot import from a backup of the PackMaster database. The pack leader must use 
PackMaster�s Graduate to Boy Scouts option. 

 
This same feature is accessible through the File>Import Cub Scouts menu option. 

 
5.8 Receive Scouts From Another Unit 
 

You can electronically receive scouts from another unit using TroopMaster ME if that unit 
created a set of transfer files (see para. 5.9). Enter the path to the transfer files and click OK. 
This function will import virtually all of the data on each scout except attendance at specific 
activities; for those, it will store each scout�s total attendance (i.e., total nights camped, total 
miles hiked, etc.) in the Activities>Set Prior Totals area (see para. 7.2). 

 
If the other unit also transferred adults, see paragraph 8.1g. 

 
5.9 Transfer Scouts to Another Unit 
 

If some of your scouts/adults are moving to another unit that uses TroopMaster ME, this 
option will create a set of transfer files that will save the other unit leader from having to 
enter the members manually. Running this option will not delete the members from your unit. 
Enter the target location (usually a diskette) for the transfer files. Then, highlight all of the 
transferring scouts and adults and click Transfer Members.  

 
You must transfer all of the departing members before leaving this dialog. Each time 
you use this dialog, TroopMaster creates a new set of transfer files. Previously created 
transfer files, if any, will be erased. 

 
This same dialog is accessible through the Adults>Adult Members menu.  
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CHAPTER 6. ADVANCEMENT 
 
6.0 Overview 
 

You will initially enter all of your advancement data through the Individual Advancement 
dialog. After retrieving a scout's advancement records, you can select any area for data entry 
or review. The rank toward which the scout is currently working is automatically highlighted. 
In addition to the rank badges, there are also list box options for palms, partial merit badges, 
completed merit badges, and advancement remarks. After selecting any of these options, you 
can then �page� sequentially to any of the other advancement dialogs. In addition, quick 
access buttons allow you to jump directly to the scout�s personal data, leadership, training, or 
special awards dialogs.  

 
The �Inactive� checkbox allows you to turn off automatic credit (see Appendix B) of the 
Star, Life, and Eagle �Participation� requirements.  

 
The Merit Badges-Completed dialog (see para. 6.9) lets you enter all of a scout�s completed 
merit badges on one dialog and have TroopMaster place them under the appropriate ranks for 
you based on BSA rules. If you would prefer to manually place the badges on the various 
rank dialogs, check the �Manual MB Placement� checkbox. 

 
In �Manual MB Placement� mode, TroopMaster will still monitor your entries to ensure that 
a sufficient number of Eagle-required badges are entered for each rank. However, the 
program will not stop you from entering a merit badge under the �wrong� rank. For example, 
even if a scout still needs Eagle-required badges for Star, TroopMaster will not stop you from 
entering an Eagle-required badge under Life. In selecting manual mode, you assume most of 
the burden for ensuring that the scout advances according to BSA rules. 

 
If �Manual MB placement� has not been selected, a merit badge you credit via group 
advancement or the individual rank dialogs will be placed exactly the same as if you had 
entered the badge on the Merit Badges-Completed dialog.  

 
TroopMaster has a feature that allows you to disable the Eagle-required merit badge rules for 
disabled scouts. Please see Appendix D. 

 
If the scout is a Venturer, check the associated checkbox and use the radio button to switch to 
the Venturing awards list (see para. 6.12). 

 
6.1 Date Entries 
 

Dates can be entered for all requirements including those that TroopMaster automatically 
monitors and credits. �Boards of Review� dates (and Venturing award completion dates) are 
reviewed for accuracy. For example, a Board of Review should not be entered unless all 
other requirements for the rank are complete. TroopMaster will alert you to errors it detects. 
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In addition to the standard date entry formats accepted throughout TroopMaster, several 
additional options are available in the advancement area. For example, if you don�t know the 
specific date on which a scout completed his �Patrol Cook� requirement, just type a C as the 
first character of the date field, and TroopMaster will enter the word �Complete� as the date. 
Similarly, entering an N will result in a date entry of �N/A� (meaning that BSA added this 
requirement after the scout completed the rank). Please see paragraph 2.6 for a description of 
the other options available.  

 
Actual dates (M/D/Y) are required for completion dates for all special awards, Venturing 
awards, merit badges, and Boards of Review.  

 
6.2 Merit Badge Placement 
 

With the BSA advancement rules changes of 1999, there are now three different lists of 
Eagle-required merit badges that a scout could have used to earn Eagle. The badge list that a 
scout may use or has to use in earning a rank depends on the time frame during which he 
completes the requirements for each specific rank. TroopMaster monitors this and 
automatically adjusts the advancement rules based on the rank requirement completion dates 
you enter for each scout. Appendix C discusses the three badge lists and how TroopMaster 
handles them. Please stop now and carefully read Appendix C. It is very important that 
you understand how this works. 

 
If �Manual MB placement� has not been selected, TroopMaster will automatically place 
newly credited merit badges under the appropriate rank based on the badges the scout has 
already earned and BSA advancement rules. Automatic badge placement works the same 
way regardless of whether you credit badges via the senior rank dialogs, the Merit Badges-
Completed dialog, or Group Advancement. When appropriate, previously credited merit 
badges will be relocated based on the type and completion date of the new badge being 
credited. 
 
For Star, Life, and Eagle, a note at the top of each dialog will tell you how many of the 
remaining open slots must be filled with badges from the Eagle-required list. TroopMaster 
will not let you credit a non-Eagle badge toward a rank if all remaining merit badges for that 
rank must be Eagle-required badges. 

 
The automatic merit badge placement function never adjusts or relocates merit badges 
credited under completed ranks. If you need to do that, you�ll need to temporarily 
demote the scout to a rank below the one you wish to adjust. If you only need to modify 
the date on one of the merit badges, you can do so without demoting the scout by 
double-clicking on the badge. 

 
To change a date for any of the previously entered badges, double-click the entry and enter 
the new date in the pop-up window. 

 
To remove a previously entered badge, go to the Merit Badges-Completed dialog or to the 
associated rank dialog, highlight the badge, and click Remove. 
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Outdated merit badges, such as Signaling, are still included on the menus in case a scout 
earned or started the badge before it was dropped. Outdated badges are marked with a �#� 
(pound sign). 

 
6.3 Reported/Presented Flags 
 

Sometimes a scout does not tell you about a merit badge he earned until after the Unit 
Advancement Report (4403) has already been submitted to the council office. Also, some 
scouts miss the Court of Honor and you need a way of reminding yourself to present their 
awards at the next Court. 

 
For merit badges and rank badges, TroopMaster tracks whether the award has been reported 
to the council office. For merit badges, rank badges, and special awards, it also tracks 
whether the awards have been presented (see  Note  below) to the scouts. The 
reported/presented flags are shown on the rank dialogs with �R/P� check boxes, and on the 
Special Awards dialog by a �Yes/No� column in the list box. 
 
Whenever you generate a Court of Honor report (see para. 12.3c), TroopMaster will 
optionally include awards earned prior to the �From� date of the report if the �Presented� 
flags are not checked. When it is finished generating the report, TroopMaster optionally sets 
the �Presented� flags for all the awards on the report. If a scout misses the Court, you should 
retrieve his records and clear the appropriate �Presented� flags. 
 
When you generate the Unit Advancement Report (4403) for your council (see para. 12.3c), 
TroopMaster will optionally include any badges earned prior to the �From� date if the 
�Reported� flags are not set. When it is finished generating the report, TroopMaster 
optionally sets the �Reported� flag for all of the badges included on the report. 

 
We recognize that badges and awards are generally given to a scout as soon as he earns them. 
The term �Presented� in TroopMaster refers to the act of officially recognizing the scout at a 
Court of Honor. 

 
6.4 Scout, Tenderfoot, 2nd/1st Class Ranks 
 

Requirements for these ranks follow the 2001 BSA advancement rules.  
 

If you don�t have or don�t wish to enter dates for all of the requirements for these ranks, just 
enter the Board of Review date and TroopMaster will blanket-fill the remaining requirements 
with the word �Complete.� 

 
In January of 1999, BSA added several new requirements to these early ranks, and in 2001 a 
subsequent new requirement was added to Tenderfoot. If a scout completed one or more of 
these ranks before the rules changed, enter N/A next to the new requirements. 
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TroopMaster automatically tracks and credits the 2nd/1st Class activity requirements if you 
are recording unit activities in that area of the program. Only those activity types that you 
have marked as valid are considered. In addition, the camping minimum must be met. 
TroopMaster also automatically credits the 2nd Class service project requirement based on 
service project activities. 

 
Your unit committee can waive some of the 2nd/1st Class swimming requirements. 
Accordingly, the �Waived� (see para. 2.6) option is valid for those items. 

 
See paragraph 6.3 for a description of the �R/P� check boxes. 

 
6.5 Star Rank 
 

This rank requires six merit badges including at least four from the required list for Eagle. If 
you are in automatic badge placement mode, TroopMaster will place these badges for you. 
TroopMaster also monitors the �Participation�, �Position of Responsibility� and �Service 
Project� requirements for you and will automatically enter completion dates as soon as these 
requirements are satisfied. Please see Appendix B for more information on auto-crediting of 
requirements. 

 
If you are in manual badge placement mode, TroopMaster will ensure that you enter at least 
four Eagle-required badges under this rank. If the scout has earned more than two non-Eagle 
merit badges, enter two here and apply the others to the next higher rank where they will fit. 
However, 12 of the 21 merit badge slots under Star, Life, and Eagle are reserved for the 12 
Eagle-required merit badge categories. 

 
TroopMaster will count any of the 15 merit badges on the Eagle-required list toward the four 
that are required for this rank, even if two or more of the badges are from the same Eagle-
required category. The categories are not a factor until a Life scout begins working toward 
Eagle. Please see Appendix C and also the Star rank requirements in the Boy Scout 
Handbook. 

 
See paragraph 6.3 for a description of the �R/P� check boxes. 

 
6.6 Life Rank 
 

This rank requires five more merit badges, including three more from the Eagle-required 
merit badge list. However, if the scout earned more than four Eagle-required merit badges for 
Star, he will need less than three here (total of 7 from the current Eagle-required merit badge 
list). TroopMaster also monitors the �Participation�, �Position of Responsibility� and 
�Service Project� requirements for you and will automatically enter completion dates as soon 
as these requirements are satisfied. Please see Appendix B for more information on auto-
crediting of requirements. 
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TroopMaster will count any of the 15 merit badges on the Eagle-required list toward the total 
of seven Eagle-required badges that are required for this rank, even if two or more of the 
badges are from the same category. The categories are not a factor until a Life scout begins 
working toward Eagle. Please see Appendix C and also the Life rank requirements in the Boy 
Scout Handbook. 

 
6.7 Eagle Rank 
 

When a scout earns Life, TroopMaster changes the way it counts Eagle-required merit 
badges. From this point on, only one badge from each of the 12 categories is counted as 
Eagle-required (see Appendix C and the Eagle rank requirements in the Boy Scout 
Handbook). TroopMaster also monitors the �Participation� and �Position of Responsibility� 
requirements for you and will automatically enter completion dates as soon as these 
requirements are satisfied. Please see Appendix B for more information on auto-crediting of 
requirements. 

 
6.8 Palms 
 

This dialog provides a place to record advancement if a scout progresses beyond the Eagle 
rank. There are sufficient palms to credit advancement even if a scout earns all of the 
available merit badges. TroopMaster will display the next available palm whenever you 
select this dialog, but you can view any palm desired just by clicking the corresponding 
button. 

 
6.9 Merit Badges-Completed 
 

This dialog makes it very easy to enter any or all of the merit badges a scout earns. Highlight 
a badge, enter the completion date, and click Add. TroopMaster will automatically analyze 
the scout�s advancement records and place the new badge under the most appropriate rank. 
When appropriate, previously placed merit badges will be relocated. 

 
The automatic merit badge placement function never adjusts or relocates merit badges 
credited under completed ranks. If you need to do that, remove the �Board of Review� 
date for that rank. 

 
6.10 Merit Badges-Partial 
 

Use this option to track up to 15 merit badges that the scout has started but not yet 
completed. To add a new badge to the list, select it from the drop-down menu and click Add. 
To update any badge on the list, highlight it. For each badge, you can enter a �Start� date as 
well as the most recent date on which the scout completed any of the requirements. There are 
also checkboxes for you to mark which requirements are complete and a �Remarks� field. 
When the scout completes the badge, highlight it, click Credit Badge, and enter the 
completion date in the pop-up window, 
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You can also credit the badge from several other advancement dialogs. When you credit the 
scout with completion of one of these badges via this or any other dialog, TroopMaster 
automatically removes the badge from this list. To remove a badge manually, highlight it and 
click Remove Badge. 

 
If BSA revises the requirements for any of the merit badges, you can update the requirements 
list through the Advancement>Modify MB Requirements option. 

 
6.11 Remarks 
 

This dialog allows you to enter advancement remarks, such as a service project description. 
Remarks will be printed on the Individual Progress, Individual History, and Board of Review 
reports. 

 
6.12 Venturing Awards 
 

For Venturers, TroopMaster tracks the five Bronze Awards, the Ranger Award, and the 
Gold/Silver Awards. Check the �Venturing� checkbox to switch to this list. Because the 
Outdoor Bronze Award and the Ranger Award share the same list of core requirements and 
electives, these two awards share the same dialog, but there are separate "Earned" dates for 
each award. 

 
All of the Venturing award dialogs operate in generally the same manner; i.e., you can enter 
completion dates for each of the requirements followed by an award earned date. If you 
prefer not to track the individual requirements, you can simply enter the award completion 
date and TroopMaster will blanket-fill individual requirements with the word "Complete" 
(exception: the Outdoor Bronze and Ranger awards allow the Venturer to choose which core 
requirements and electives to complete, so TroopMaster will not blanket-fill this dialog). 
 
One of the Bronze Awards should be designated as the Venturer's "primary" bronze award. 
This is the award that the Venturer plans to apply toward completion of the Silver Award. 
There is a checkbox on each of the Bronze Award dialogs for this purpose. If you don't 
designate one of the awards as primary, TroopMaster will automatically mark as "primary" 
the first award toward which you enter a requirement completion date. The reason for 
designating a primary Bronze Award is that TroopMaster will include this award on the 
Gold/Silver Award report (see para. 12.10c). You can change which award is designated as 
primary at any time. 

 
6.13 Special Awards 
 

Each scout can earn up to 80 special awards. You can select from a menu of awards you 
defined on the Define Scout Awards dialog (see para. 5.3), or you can click Other and define 
a new award on the fly. After selecting the award, enter the completion date in the pop-up 
window. 

 
To change a date for any of the previously entered awards, double-click the entry and enter 
the new date in the pop-up window. 
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As much as possible, you should credit awards by selecting from the menu. Then, when 
you print a list of scouts having or needing a special award, TroopMaster searches for 
the exact spelling (search is not case-sensitive). If you make frequent use of the �Other� 
option, make sure you spell the awards consistently or the �having/needing� reports 
will not be accurate. 

 
See paragraph 6.3 for a description of the �Presented� column. To toggle the �Yes/No� status 
of an award, highlight the award and click the Presented button. 

 
6.14 Training Courses 
 

Each scout can be credited for attending up to 20 training courses. You can select from a 
menu of courses you defined on the Define Scout Training dialog (see para. 5.4), or you can 
click Other and define a new course on the fly. After selecting the course, enter the 
completion date in the pop-up window. 

 
To change a date for any of the previously entered courses, double-click the entry and enter 
the new date in the pop-up window. 

 
As much as possible, you should credit courses by selecting from the menu. Then, when 
you print a list of scouts having or needing a training course, TroopMaster searches for 
the exact spelling (search is not case-sensitive). If you make frequent use of the �Other� 
option, make sure you spell the courses consistently or the �having/needing� reports 
will not be accurate. 

 
6.15 Group Advancement 
 

This powerful capability makes it easy to credit advancement, awards, or training earned by a 
group of scouts at the same time. For example, if you start a merit badge class, you can 
update the partial merit badges for those scouts without having to retrieve their advancement 
records one at a time. Similarly, when the class is complete you can use group advancement 
to credit all of the scouts who earned the badge. Early rank requirements, special awards, and 
training courses can be credited in the same manner.  

 
Regardless of the item being credited, TroopMaster will automatically retrieve each of the 
scouts' records and make the required entries. If it encounters any problems, TroopMaster 
will credit as many scouts as possible and then present a results window showing the scouts 
on whom it had difficulties. For example, if a scout already had credit for a merit badge, he 
will be listed under �Duplicates�. If TroopMaster reports errors for a scout, a more serious 
problem was encountered. You should retrieve that scout's records and attempt to credit the 
item manually to see what the problem was. 

 
a. Early Rank Requirements. This can be used to credit any of the requirements for 1st 

Class and below. Select the requirements and enter the completion date. Then, select the 
scouts to be credited. Select multiple scouts or requirements by holding down the CTRL 
key and clicking the desired names or items, or by holding down the SHIFT key and 
clicking an entry at the end of contiguous group of names/items. Click Process to credit 
the requirements. 
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b. Merit Badges. This dialog can be used to credit completed merit badges and also to add 
or update partial merit badges (i.e., badges in progress) for your scouts. Select the desired 
badge from the drop-down list and then select the appropriate scouts as described in 
paragraph 6.15a. Then: 

 
(1) Completed Merit Badges. Check the �Completed� radio button, enter the completion 

date, and click Process to credit the badge. TroopMaster will add the badge to each 
scout�s advancement records.  

 
For scouts who are in automatic badge placement mode, TroopMaster will place the new 
badge in the same manner as if you had entered it on the scout�s Merit Badges-Completed 
dialog.  

 
If you attempt to credit a completed merit badge for a scout who is in manual badge 
placement mode, TroopMaster will alert you and ask if you wish to place the badge 
anyway. If you answer �Yes�, TroopMaster will place the badge using the same 
guidelines as though the scout were in automatic badge placement mode. Existing 
badges may be relocated, as appropriate. 

 
(2) Partial Merit Badges. Enter the date, if any, that the scouts last made any progress 

toward the badge. If any of the requirements are complete, check the corresponding 
checkboxes. Lastly, click Process. TroopMaster will examine each scout�s partial 
merit badges. If the badge is not already there, TroopMaster will add it. If the badge 
is already one of the scout�s partially completed badges, TroopMaster will update the 
badge with the new information. 

 
If you are updating an existing badge in progress, you do not need to recheck requirements 
that were previously marked as completed in the scouts� records. For example, if the only 
thing new is that the scouts have completed requirement #6, you just need to check that one 
checkbox. 

 
c. Special Awards Earned. Select the desired award from the menu of awards you defined 

on the Define Scout Awards dialog, or type an award name in the �Other� field. Enter a 
completion date and then select the desired scouts as described in paragraph 6.15a above. 
Click Process to credit the award. 

 
d. Training Completed. Select the desired course from the training menu you defined on the 

Define Scout Training dialog, or type a course name in the �Other� field. Enter a 
completion date and then select the desired scouts as described in paragraph 6.15a above. 
Click Process to credit completion of the course. 

 
Since it is legal to credit some awards and training courses more than once, TroopMaster will 
credit duplicates as long as the completion date is different. 

 
6.16 Add New Merit Badges 
 

Use this option to add merit badges to your system as BSA approves new ones. While 
Troopmaster Software will make every effort to keep TroopMaster current with BSA 
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standards, this display allows you to update the system yourself if the only change is a new 
merit badge.  

 
When you add merit badges, it is important to use the same numbers as assigned by 
BSA. We publish the official numbers of new badges on the Announcements page at our 
Internet site. 

 
6.17 Eagle Honor Roll 
 

This dialog provides a visual history of all of your Eagles, past and present. Whenever you 
promote a scout to Eagle, TroopMaster will automatically add him to this list. To add a prior 
Eagle manually, just enter his name, the date he earned Eagle, and click Add. You can view 
the list sorted by name or date. 

 
6.18 Modify Merit Badge Requirements 
 

The merit badge requirement numbers included in TroopMaster were based on Boy Scout 
Requirements 2001, published by BSA. Periodically, BSA will add new merit badges and 
revise the requirements on existing ones. When they do, you can use this dialog to update the 
requirement numbers. 

 
First, select the badge to be updated from the drop-down menu. Enter the correct requirement 
numbers in the �Reqt #� fields. If you need to insert a new requirement, click the >> button 
at the insertion point. To erase a requirement, click X. You can update as many of the badges 
as needed before leaving the dialog. 
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CHAPTER 7. ACTIVITIES 
 
7.0 Overview 
 

TroopMaster will track attendance of your scouts and adult leaders at campouts, hikes, 
meetings, service projects and up to 11 user-defined activity types. Up to 1000 activities can 
be tracked. Activities can be entered in advance (this allows you to produce a unit calendar) 
or you can enter the activity and attendance at the same time. TroopMaster also provides a 
Set Prior Totals dialog so that you can credit scouts and adults for nights camped, miles 
hiked, etc., that they completed before joining your unit. 

 
7.1 Activity Management 
 

As the name implies, this option allows you to add new activities to your database and to 
review/edit any of the data on existing activities. Use the Add New button to enter new 
activities. When you review existing activities, you can view all of them or you can narrow 
the review down to activities of a specific level (troop, crew, team, etc.) and/or type (camps, 
hikes, meetings, etc.) 

 
If you select a specific level and/or type before clicking Edit/Review, then the 
Previous/Next buttons on the Edit/Review Activity dialog will let you �page� through the 
activities of the selected level and type. 

 
a. Add New Activity. Standard items include activity type, date, start time, amount, (e.g., 

nights camped, miles hiked, hours worked, etc.), location, and remarks. The �Activity 
Type� field provides a drop-down menu of types you defined on the Define Activity 
Types dialog. Click the Define Types button to access this dialog. Click the Description 
button to enter a text description of the activity. 

 
If the activity was a campout, two additional checkboxes are available: �Summer Camp� and 
�Cabin Camp�. If either applies, check the box. These two items are important because 
TroopMaster uses these in computing �Nights Remaining� for the Scouts Needing Camping 
MB report (see para. 12.3j), and when computing O/A Eligibility. 

 
The �Credit toward 2nd/1st Class� check box lets you decide whether or not to count each 
activity toward automatic credit (see Appendix B) of the 2nd/1st Class activity requirements. 
For example, if you hold a camp and a hike on the same day, you may only want one of the 
two to be credited toward these requirements. TroopMaster gets the default value from the 
Define Activity Types dialog (see para. 7.3). 

 
The Combined button is provided to save you time when two or more activities are being 
held in conjunction with one another. For example, you may have scheduled a hike and/or a 
service project as part of a campout. This button is most useful when you already know who 
attended, so use of the button is described in paragraph 7.1b(1). 

 
The Generate Schedule dialog (see para. 7.5) lets you automatically create a schedule of 
weekly/monthly activities (such as meetings) and add these to your activities file. 
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b. Edit/Review Activities. This option is most often used to mark attendance but it also 
enables you to review or change any previous entries. Note that in �Edit/Review� mode, 
you can move to the next or previous activity via the buttons provided. 

 
To review activities of a single level and/or type, select those on the Activity Management 
dialog before clicking Edit/Review. The Next and Previous buttons will then let you �page� 
through activities of the selected level and type. 

 
The Delete button should only be used to remove activities that were canceled or 
entered in error. If you need to clear out old activities to make room for new ones, use 
the Delete Activities dialog (see para. 7.4). Otherwise, attendance totals for the activities 
will be lost. Attendance totals at activities removed through the Delete Activities dialog 
are automatically added to scout and adult amounts in the �Set Prior Totals� area. 

 
(1) Combined Activities. Sometimes two or more activities are held in conjunction with 

one another. For example, you may have held a campout that included hiking and a 
service project. To save you from having to enter all of the information including 
attendance three times, TroopMaster provides a Combined button. The campout was 
probably entered in advance because you would have wanted it to be included on 
your unit schedule.  

 
First, retrieve the campout and enter the scout/adult attendance. When finished, click 
Combined and TroopMaster will save your attendance entries, switch you to �Add 
new activity� mode, and erase only the �Type� and �Amount� fields. Next, change 
the type to �Hiking� and enter the length in the �Miles� field. If you don�t want the 
scouts getting double credit for the 2nd/1st Class activity requirement, clear that 
checkbox. Adjust the attendance, if necessary, and click Combined again. Lastly, 
make the service project entries and click OK. TroopMaster will save the information 
on all three activities. 

 
(2) Crediting Attendance. Crediting attendance is very flexible. For example, there are 

several ways to list your scouts and adults while marking attendance. This is 
controlled through the �List Currently Displays� field. The default list is �All Scouts� 
but you may prefer to mark scout attendance by patrol. To record adult attendance, 
select the �All Adults� option. 

 
To mark attendance, select the applicable members by holding down the CTRL key 
and clicking the desired names, or by holding down the SHIFT key and clicking a 
name at the end of a contiguous list. Then, enter an appropriate �Attendance Marker� 
field and click Apply. Scouts and adults can be credited for attending the same 
activity. 

 
Marking attendance is even easier if you enter an attendance marker and then double-click 
the names of the scouts and adults who attended. 

 
If you accidentally credit the wrong person, double-click the name again to erase the entry. 
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The �Attendance Marker� is very flexible. Using a letter (e.g., X) to mark attendance 
gives the scouts credit for the entire activity amount (e.g., night camped, miles hiked, 
etc.). On the other hand, numbers have special meaning. If the activity is a campout, a 
numeric attendance marker overrides the �Nights� field. For example, if a scout only 
stayed for the first night of a two-night campout, change his attendance marker from X 
to a 1 (one), and he will be given credit for only one night. Numbers can also be used for 
other activity types. This allows you to make individual entries for things like service 
project hours worked, miles hiked, etc. 

 
Non-numeric entries must be a single character. Numeric entries can be four digits. 
TroopMaster will also track tenths. For example, when crediting service hours you might use 
a marker of 2.6 hours. 

 
An asterisk (*), if entered in the attendance column, indicates that the individual did not 
attend but was excused. Excused absences are not considered when computing attendance 
percentages for the Unit Participation Summary report. 

 
Use non-numeric entries to record things other than simple attendance. For example, an entry 
of E on a campout could indicate the scout attended and had an equipment inspection. 

 
7.2 Set Prior Totals 
 

This option helps ensure that the grand totals for each scout and adult are accurate. Use this 
dialog to enter nights camped, miles hiked, service project hours, etc., that the scout/adult 
completed before joining your unit. For the Unit Activity Totals report and the Individual 
History reports, TroopMaster will add these numbers to the amounts in your active database. 

 
Because there are no dates associated with your entries, �prior� entries are not included on 
any activity reports that use � From-To� dates. For the same reason, �prior� camping is not 
considered when computing O/A eligibility. 

 
7.3 Define Activity Types 
 

TroopMaster tracks scout and adult participation in as many as 15 different types of 
activities. Since camping, hiking, meetings, and service projects are the most commonly used 
types, these are pre-defined for you and cannot be changed. You can define up to 11 other 
types to meet the specific needs of your unit. For example, you might want to track outings, 
fundraisers, unit committee meetings, etc. 

 
For each new type, enter a name (which must be unique) and, if desired, a field label to be 
used for the activity �amount� field. If you want the activity type to be counted toward 
automatic credit (see Appendix B) of the 2nd/1st Class activity requirements, enter a check 
mark in the field provided. 
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TroopMaster automatically monitors and credits the activity requirements for the 2nd/1st 
Class ranks. Your entry in column three tells the program whether or not to count the activity 
types that you define. This entry will be used as the default value when you create activities 
of this type. 

 
If you create an activity type of �Driving�, you can use the attendance feature to keep track 
of how many miles each of your adults has driven in support of your unit. At the end of each 
year, you could then print Individual Participation reports for those adults, who could use 
them for tax purposes. 

  
7.4 Delete Activities 
 

This option enables you to clear out your files when you reach the system limit of 1000 
activities. Activities can be deleted by �From-To� period and by activity types/levels. This 
flexibility allows you to selectively clear activities like old meetings from your files while 
retaining more important activities, such as camping and hiking. 

 
To avoid having unwanted amounts being added to scout/adult �prior� totals, delete 
erroneous activities by displaying the activity and clicking Delete. 

 
7.5 Generate Schedule 
 

This option makes it easy to create a schedule of weekly or monthly activities and add those 
to your activities file. For example, let�s suppose you want to create a schedule of weekly 
meetings. Select type �Meeting� from the drop-down list. Then, check �Include on calendar� 
since you definitely want your meetings on your unit calendar. Meetings don�t count toward 
completion of the 2nd/1st Class activity requirements, so leave that checkbox blank. Enter an 
amount (usually zero unless you�re using some type of point system), your meeting location, 
and remarks, if desired.  

 
Then, enter the date of the first scheduled meeting in the �From� field and the date of the last 
meeting in the �To� field. Select the �Weekly� option. Lastly, click Generate and 
TroopMaster will automatically create a full schedule of meetings based on the weekday of 
the first meeting date, and it will display the generated dates in the list box. 
 
Before saving these meetings to your activities file, check the list for holidays, etc. For 
example, if there will be no meeting during Christmas week, highlight that date and click 
Remove. When all of the remaining dates are correct, click Save and TroopMaster will add 
all of the scheduled meetings to your activities file. 
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CHAPTER 8. ADULTS 
 
8.0 Overview 
 

TroopMaster allows you to track your adult members, points of contact, and merit badge 
counselors. 

 
8.1 Adult Members 
 

This area allows you to track adult members of your unit. Because some units want to be able 
to track attendance for adults who are not strictly unit leaders, there is a checkbox to indicate 
which of the adults are leaders. 

 
a. Adult Management. As the name implies, this option allows you to add new adults to the 

unit and to edit/review data on existing adults. The Add New and Personal Data buttons 
access the same tabbed dialog for data entry. Additional buttons allow you to access the 
other areas of each adult�s records. If you need to delete or archive an adult, use the 
Del/Archive button on the adult personal data dialog. 

 
(1) Personal Data. A brief description of each tab follows.  

 
(a) Personal #1. In addition to name and address, this tab has fields for date of birth 

(DOB), social security number (SSN), and driver�s license number/state. Fields 
marked with asterisks are required for the BSA ScoutNET interface (see para. 
12.9f), but only for adults who have been or will be assigned leadership positions. 
A separate mailing address field is available if the adult's mailing address is 
different from his street address. If the new adult was a Boy Scout, enter the 
highest badge earned. If he is an Eagle Scout, enter the date he earned his Eagle. 
If you want to attach a photo of the adult, click the Photo button and browse to 
the appropriate JPG, GIF, or BMP file. You can create family links to the parents, 
merit badges counselors, and POCs files. Please see Chapter 15 for more 
information on family links.  

 
Many units have requested the addition of social security number fields, but collecting 
SSN�s raises Privacy Act issues. You may wish to consult an attorney before doing so. 

 
The adult�s formal first name will be used on reports that go to council, but normally his 
nickname will be used on all other displays and reports. If desired, you can choose to use 
formal name throughout the program-see the File>Preferences option.  

 
If the new adult is also a unit leader, click the check box and enter a date in the �Became 
Leader� field. This date is used to compute completion of service stars for the Court of 
Honor report. If the leader has had breaks in service, enter the date he began his current 
service in this field and enter previous periods of service on the �Prior Service� tab.  

 
The �Joined Unit� date is used in computing attendance percentages. 
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The �Highest Badge Earned� field is considered when computing O/A eligibility. To be 
eligible, adults who are under 21 must have reached at least the 1st Class rank. 

 
If all or most of your adults have the same area code, enter that on the Preferences dialog and 
TroopMaster will use it as the default for all phone number fields. 

 
To email an adult, just click the button next to his email address. 

 
(b) Personal #2. This tab lets you record medical information including the date for 

each class of physical exam. The �Special Needs� field is there in case the adult 
has a special condition that should be recorded. If so, you should click the 
Description button to more fully describe the condition. The vehicle and 
insurance fields are provided in case the adult does not have a son in the unit. 
Data entered in these fields can be included on the Unit Vehicles Report and the 
Tour Permit Assistance report. To avoid duplication on these reports, you should 
not reenter vehicles that are also on the scout personal data dialog. 
 

Special needs codes and the corresponding descriptions will be included in your annual 
recharter report for ScoutNET. 

 
(c) Prior Service. If the leader had breaks in service, enter the date he began his 

current service in the �Became Leader� field on the �Personal #1� tab. Enter the 
�From-To� dates of previous service on this tab. For each line entry, there are also 
fields for level, unit number, and council number. The total amount of prior 
service will be added to the leader's current service when computing service stars 
for the Court of Honor report. 

 
(d) Remarks/Other. This tab provides a place for you to enter information for which 

there are no pre-defined data fields. In addition to a remarks field, there are eight 
user-defined fields: four text fields and four checkboxes. You can enter your own 
label for any of these fields by clicking the existing label and then entering a new 
label. For example, you might redefine one of the text field labels as �Hobbies� or 
use one of the checkboxes to indicate �Fees Paid�. Whatever field labels you enter 
for any adult will be used for all of your adults. TroopMaster has a special report 
for the user-defined data fields. 

 
When you click OK, TroopMaster will save your entries. If you are in �Add� mode, 
TroopMaster will clear the display so that you can add another adult, if desired. Since 
city, state, and zip code are often the same or similar for all adults in a unit, those 
fields will not be cleared. Click Cancel when you are finished adding adults. 
 
If you are in �Edit/Review� mode, several additional buttons are available. Quick 
access buttons will take you directly to any adult�s awards, training, and leadership 
dialogs. Previous and Next buttons allow you to �page� through your adults. 
 
To archive or delete an adult, click Del/Archive. A pop-up dialog gives you the 
option of archiving (see Chapter 13) the adult before he is deleted. 
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(2) Special Awards. Each adult can earn up to 30 awards. Select from a menu of awards 
you defined on the Define Adult Awards dialog (see para. 8.1.d), or click Other and 
define a new award on the fly. Enter a completion date in the pop-up window. To 
modify the completion date of an award, double-click the award and enter a new date 
in the pop-up window. 

 
As much as possible, you should credit awards by selecting from the menu. The reason 
for this is that when you print a list of adults having or needing a special award, 
TroopMaster searches for the exact spelling (search is not case-sensitive). If you make 
frequent use of the �Other� option, make sure you spell the awards consistently or the 
�having/needing� reports will not be accurate. 

 
See paragraph 6.3 for a description of the �Presented� column. To toggle the �Yes/No� status 
of an award, highlight the award and click the Presented button. 

 
(3) Adult Leadership. This dialog handles the adult�s current leadership assignment(s) 

and leadership history.  
 

(a) Current Positions. To assign a leader to a position, select it from the drop-down 
menu of leadership positions. If the desired position is not on the menu, click the 
Define Positions button and add it. You can assign up to four current positions to 
each leader.  

 
To remove a leader from a previously entered position, select the blank position 
from the drop-down list and enter the date he vacated the previous position. 

  
To help ensure that a leader is reported correctly on the Council Recharter report, list the 
more important position as position #1. 

 
When a leader changes leadership positions, the vacated position is automatically moved to 
the leadership history list. The �Effective Date� of the new position is used as the closeout 
date of the old position.  

 
(b) Leadership History. This area allows you to enter previous positions (maximum 

15) in which the adult served. To add a position to the list, select it from the drop-
down menu. Enter the �From-To� dates and click Add. To remove a position 
from the list, highlight the position and click Remove. 

 
Leadership history is included on the adult�s Personal Data report. If a leader 
serves in more than 15 positions, the oldest one is dropped when a newer one is 
added to the list. 

 
When you assign a leader to the Patrol Advisor position, you can optionally select a patrol 
name from the pop-up menu. If you do, that leader will be printed with his patrol on the 
Patrol Roster. Patrol Advisors are listed as Assistant Scoutmasters on the Council Recharter 
report. 
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(4) Order of the Arrow (O/A). Click this button to enter or review O/A data on the 
selected adult. See Chapter11 for more information. 

 
(5) Training. Each adult can be credited with up to 30 training courses. Select from a 

menu of courses defined on the Define Adult Training dialog (see para. 8.1.e), or click 
Other and define a new course on the fly. Enter a completion date in the pop-up 
window. To modify the completion date of a course, double-click the course and 
enter a new date in the pop-up window. 

 
As much as possible, you should credit courses by selecting from the menu. The reason 
for this is that when you print a list of adults having or needing training, TroopMaster 
searches for the exact spelling (search is not case-sensitive). If you make frequent use of 
the �Other� option, make sure you spell the courses consistently or the 
�having/needing� reports will not be accurate. 

 
b. Group Credit. This feature makes it easy to credit special awards or training completed 

by a group of adults at the same time. For example, if several of your adults complete 
CPR, you can update their training records without having to retrieve them one at a time. 
If TroopMaster reports errors for an adult, you should retrieve that adult�s records and 
attempt to credit the item manually to see what the problem was. 

 
(1) Special Awards Earned. Select the desired award from the menu of awards you 

defined on the Define Adult Awards dialog, or type an award name in the �Other� 
field. Enter a completion date, select the desired adults, and then click Process to 
credit the award. 

 
(2) Training Completed. Select the desired course from the training menu you defined on 

the Define Adult Training dialog, or type a course name in the �Other� field. Enter a 
completion date, select the desired adults, and then click Process to credit completion 
of the course. 

 
TroopMaster will credit a duplicate award or course as long as the completion date is 
different. 

 
c. Define Adult Leadership. TroopMaster comes with a menu of adult leadership positions. 

Use this dialog to define additional ones, if needed. Your entries will appear on a 
positions menu that is presented whenever you assign a position to one of your adults. 

 
d. Define Adult Special Awards. Use this dialog to define the most common special awards 

presented by your unit. Your entries will appear on an awards menu that is presented 
whenever you credit an adult with an award. However, you can credit awards that are not 
on the menu by using the �Other� option (see para. 8.1a(2)). 

 
e. Define Adult Training Courses. TroopMaster comes with an extensive menu of official 

BSA training courses. Use this display to define additional courses, if needed. Your 
entries will appear on a training course menu that is presented each time you credit an 
adult with a course. However, you can credit courses that are not on the menu by using 
the �Other� option (see para. 8.1a(5)). 
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As much as possible, you should credit completion of training using the official list of 
courses because TroopMaster has an internal list of course codes associated with the 
official list. TroopMaster uses these codes to report adult training in ScoutNET reports. 
There is no way to report user-defined training to ScoutNET. 

 
f. Retrieve from Archive. If an adult you archived later returns to your unit, you can 

retrieve his data through this option. See Chapter 13 for more information on use of the 
archive. 

 
g. Receive Adults From Another Unit. You can electronically receive adults from another 

unit using TroopMaster ME if that unit creates a set of transfer files (see below). Enter 
the path to the transfer files and click OK. This function will import virtually all of the 
data on each adult except attendance at specific activities; for those, it will store each 
adult�s total attendance (i.e., total nights camped, total miles hiked, etc.) in the 
Activities>Set Prior Totals area. 

 
If the other unit also transferred scouts, see paragraph 5.8. 

 
h. Transfer Adults To Another Unit. If some of your scouts and adults are moving to 

another unit that uses TroopMaster ME, this option will create a set of transfer files that 
will save the other unit leader from having to enter the scouts and adults manually. 
Running this option will not delete the scouts and adults from your unit.  

 
First, enter the target location (usually a diskette) for the transfer files. Then, highlight all 
of the transferring scouts and adults and click Transfer Members.  

 
You must transfer all of the departing members before leaving this dialog. Each time 
you use this dialog, TroopMaster creates a new set of transfer files. Previously created 
transfer files, if any, will be erased. 

 
This same dialog is accessible through the Scouts menu.  

 
8.2 Merit Badge Counselor Management 
 

As the name implies, this option allows you to add new counselors to the unit and to 
edit/review data on existing counselors. The Add New and Edit/Review buttons access the 
same data entry dialog. You can assign up to 30 merit badges to each counselor by 
highlighting the desired badges and clicking Add. You can create family links to the parents, 
adults, and POCs files. Please see Chapter 15 for more information on family links.  

 
To assign a badge quickly, just double-click the badge name. 

 
To remove a counselor, click Delete. You will be asked to confirm the request before the 
counselor is removed. 
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8.3 Points of Contact (POCs) 
 

This provides a powerful tool for tracking information on people who are important to the 
operation of your unit but who are not necessarily adult members. District leaders are 
obvious examples, but the list also includes parents with specific skills or interests that could 
be helpful to the unit. 

 
a. POC Management. As the name implies, this option allows you to add new POCs to the 

database and to edit/review data on existing POCs. The Add New and Edit/Review 
buttons access the same data entry dialog. Most data fields are self-explanatory, but the 
�Category� and �Skills/Interests� fields provide special flexibility on reports.  

 
Because the types of people entered as POCs are frequently diverse, it is helpful to be 
able to group them into categories. You can define up to 20 different categories on the 
Define POC Categories dialog (see below). Then, when you add a new POC, simply 
assign him to a category from the drop-down list. The POCs List report includes options 
to select a specific category or to group your POCs by category. You can create family 
links to the parents, adults, and merit badge counselors files. Please see Chapter 15 for 
more information on family links.  
 
The �skills/interests� fields are designed to handle parent resource information, but you 
will probably think of additional uses. You can enter up to four skills/interests for each 
POC. The POC List report includes options to search for POCs with specific 
skills/interests.  
 
To remove a POC, click Delete. You will be asked to confirm the request. 

 
To review POCs assigned to a specific category, select the category on the POC 
Management dialog before clicking �Edit/Review�. The Next/Previous buttons will then 
take you to the next/previous POC in that same category. 

 
b. Define POC Categories. You can make your reports more flexible and useful if you 

group your POCs into categories. For instance, you could create categories for District 
Leaders, Religious Leaders, Parents, etc. Then, when you add a new POC to your 
database, you can assign him/her to the appropriate category. 
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CHAPTER 9. FLAGS 
 
9.0 Overview 
 

The flag feature provides a very powerful method for you to get reports on subsets of your 
scouts and/or adults. 

 
9.1 Flag Adults 
 

Use this option to group adults for additional flexibility when you request reports or other 
printed output. For example, you may want to flag the adults attending summer camp with an 
S. You could then print a separate phone list, general purpose worksheet, mailing labels, etc., 
just for those adults. Five columns of flags are available. Please see paragraph 9.4 for 
guidance on how to use the flags on reports. 

 
To set flags, enter an appropriate flag, highlight the desired adults, and click the column 
header button. You can select several adults at once by holding down the CTRL key and 
clicking on multiple names, or by holding down the SHIFT key and clicking on a name at the 
end of a contiguous list. To clear previously entered flags, use a blank or null as the new flag. 

 
Many LDS units use one of the flag columns to indicate Troop, Varsity, or Crew status. This 
allows you to print separate reports for each of the levels within the unit. 

 
9.2 Flag Scouts 
 

You can assign and use flags for scouts in exactly the same manner as for adults. 
 
9.3 Define Flags 
 

This dialog lets you define the flags you plan to use. Then, when you print a report using one 
of the flag(s), your definition(s) can be printed at the top of the report. Flag definitions make 
your reports more meaningful.  

 
On this display, enter the flags and corresponding definitions. For example, you might enter 
an S in column one with a definition of �Summer Camp�. Flags do not have to be defined 
before being used on reports. 

 
9.4 Using Flags on Reports 
 

The flags allow you to get reports on specific groups of members. Although only one 
character may be assigned in each column on the Flag Adults and Flag Scouts dialogs, the 
flag fields on the report generation dialogs each accept up to 5 characters each. The Flag #1, 
Flag #2, Flag #3, Flag #4, and Flag #5 fields available through many of the report generation 
dialogs correspond to columns #1, #2, #3, #4, and #5 on the Flag Adults and Flag Scouts 
dialogs. If a scout or adult matches on any of the up to 5 characters specified in one of the 
flag fields, s/he is considered to have a match on that flag. If you make entries in more than 
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one of the three flag fields (e.g., character(s) in Flag #1 and character(s) in Flag #2), the 
scout/adult must have a match in all of the corresponding columns on the Flag Adults/Scouts 
dialogs in order to qualify for the report. 

 
Single Flag Example: Scouts attending a campout might have a C in Column #1 on the Flag 
Scouts dialog, while scouts who are going rock climbing might have an R in Column #1. To 
generate a report for all scouts who are going on either outing, you would enter CR or RC in 
the �Flag #1� field when you generate the report. To get a report on only those scouts who 
are going rock climbing, you would generate the report with only R specified for Flag #1. 
 
Multiple Flags Example: Scouts attending a campout might have a C in Column #1 on the 
Flag Scouts dialog, while scouts who are going to rock climbing might have an R in Column 
#1. Column #2 might be used to specify whether the scouts have turned in their permission 
slips for the above outings (e.g., Y or N). If you then produced a Unit Phone List and 
specified CR or RC in the �Flag #1� field and specified N in the �Flag #2� field, you would 
get a list of all scouts who are going on either outing and who have not turned in permission 
slips. You could then use this report to call and remind them. 

 
On reports, an asterisk (�*�) is a wild-card entry and will match any non-blank flag assigned 
to an individual. 
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CHAPTER 10. FUNDRAISERS 
 
10.0 Overview 
 

TroopMaster will track information on any type of fundraiser that involves sales. You can 
track sales of individual products, dollar amounts due, and payments made by your scouts. 
To help you get started, a popcorn sale is pre-defined. The popcorn prices listed are not 
official prices-please adjust those as necessary.  

 
10.1 Create/Edit Fundraiser 
 

This dialog is used to create a new fundraiser or modify an existing one. You enter a unique 
name for the fundraiser and the name/retail price of up to 12 products to be sold. You can 
optionally enter a wholesale price for each item (if you do, TroopMaster will use this to 
compute profit) and you can specify if the fundraiser allows unsold items to be returned. If 
you check the �Fundraiser in Progress� checkbox, TroopMaster will use this fundraiser as the 
default when you credit scout payments or generate reports. 

 
The Delete button lets you completely remove an old fundraiser. For annual fundraisers, like 
popcorn sales, the Erase Sales button lets you clear out the old sales and payment 
information so that the new sale can be started. The existing products and prices are retained, 
but all existing sales and payments are deleted. 

 
Be sure to print any desired reports before erasing sales or deleting a fundraiser. 

 
If you would like to retain fundraiser information from previous years, you could use the 
current year as part of the fundraiser name (e.g., �Popcorn 2001�). You can then create a new 
fundraiser called �Popcorn 2002� for the following year. However, the database is limited to 
10 fundraisers. 

 
10.2 Sales and Payments 
 

This dialog lets you enter product sales and payments made by each scout. These include 
total quantities sold for each of the items in the fundraiser and, if allowed, any returns on 
those items. You can also enter the date and amount of each payment made be the scout. The 
dialog also shows the �Total Paid�, �Total Amount Due�, and �Balance� for each scout. 
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CHAPTER 11. ORDER OF THE ARROW 
 
11.0 Overview 
 

Use this option to record O/A membership information on scouts and adults.  
 
11.1 Adult O/A 
 

In addition to date fields for Election, Call Out, Ordeal, Brotherhood, and Vigil, TroopMaster 
provides fields for Vigil name, O/A leadership position, and remarks. TroopMaster also 
tracks up to six prior leadership positions. Whenever you enter a new leadership position for 
an adult, TroopMaster automatically adds his previous position to his leadership history.  

 
11.2 Scout O/A 
 

O/A information on scouts is tracked in the same manner as for adults. 
 

Special O/A Eligibility and Membership reports are available. 
 

 53 



CHAPTER 12. REPORTS 
 
12.0 Overview 
 

All system reports are included under this option. The reports are divided into 13 functional 
groups, each of which is described below. All reports are initially sent to the screen. Because 
�a picture is worth a thousand words,� only a brief description of each report is provided 
below. 
 
Most reports have several and often many different generation options. For example, the 
Individual Progress report lets you choose specific scout(s), all scouts in the unit, or all 
scouts whose advancement has changed since the last time you printed their reports. You can 
also elect to include an advancement summary and/or a list of partial merit badges. 
 
For each report, select the desired options and click OK. Displayed reports can be printed, 
emailed, or saved to a disk file.  

 
Many reports allow use of the �flags� option for scouts and adults. For more information on 
the use of flags on reports, see Chapter 9. 

 
See File>Preferences (see para 3.13) for information on adjusting your page settings, 
mailing labels settings, fonts, colors, etc. 

 
You can improve print speed on some model printers by changing the  Spool Setting from 
"Raw" to "EMF".  To do that, open "My Computer" from  your desktop, open the "Printers" 
folder, right-click on your printer and select "Properties".  Then, go to the "Details" tab. 

 
If you elect to save the report to a disk file, the report is generated and written to a file you 
specify using any of three optional formats:  

 
(1) HTML - select this format if you want to be able to review the report with your web 

browser (requires a 4.0 or newer browser). Most reports will display in your browser 
almost identically to the way they appeared in TroopMaster. However, matrix-style 
reports will lose their vertical and horizontal line separators. 

 
(2) Rich Text - Select this option if you plan to review and/or edit the report with your word 

processor. Most reports will display in your word processor almost identically to the way 
they appeared in TroopMaster. However, matrix-style reports will lose their vertical and 
horizontal line separators. 

 
(3) Plain Text - Select this option if you plan to review the report with a simple text editor, 

such as Windows Notepad. Reports saved in plain text will lose most of their formatting; 
i.e., special fonts, point sizes, bold column headers, etc., will be dropped. Just the text 
itself will be saved to the file. 

 
TroopMaster remembers your current working folder and will use it as the default, but you 
can change that if you wish, and you can use any name you like for the report file.  
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Several reports (e.g., Merit Badge Matrix, Attendance Matrix) are produced in a spreadsheet 
format with column headers at the top of the report. The default settings will print the column 
headers vertically to make them easier to read. However, if you are saving your report to disk 
or emailing it, you will need to specify the �Horizontal� table headers option when producing 
these reports. HTML, Rich Text, and plain text do not support vertical text. 

 
If you choose to email a report, TroopMaster will create a new message and attach the report 
in any of the three optional formats (i.e., HTML, Rich Text, or plain text) described above. It 
will then bring up the Send Email dialog (see para. 3.5) so that you can choose the recipients 
before sending it. 

 
You can easily email an entire set of individual member reports, one message/report per 
member. For example, you could generate a set of Individual Progress reports on all of your 
scouts and then email them to the scouts using almost the same procedure you use for 
sending a single report. However, in this case, when TroopMaster brings up the Send Email 
dialog, each of the scouts will already be listed in the �To� list box, and you will not be able 
to change this recipient list. When you click Send, TroopMaster will automatically create a 
separate message for each scout and attach that scout�s report to his individual message. 
Then, all of the individual messages will be added to your �Outbox�. Since in this case there 
are multiple messages, the �Display message prior to sending� checkbox is deactivated. 
Therefore, if you want to add or change the text of the message itself, you must do that on 
this dialog before clicking Send. 

 
12.1 Activities 
 

These options include all of the reports related to your unit activities, including camping, 
hiking, service projects, and user-defined activity types. 

 
Activity reports can be generated with or without specifying a date range. If no dates are 
specified, all activities of the selected type(s) will be included on the report. If only a �From� 
date is entered, activities on or after that date will be included. If only a �To� date is entered, 
activities on or before the �To� date will be included. 

 
Entries you may have made on the Set Priors dialog are not included on activity reports that 
use �From-To� dates because TroopMaster has no way of knowing when the �priors� were 
done. �Prior� amounts are included on the Unit Activity Totals report and can be optionally 
included on the Individual Participation and Individual History Reports. 

 
a. Activities by Type. This report provides detailed tracking of a specific activity type. It 

lists all of the activities of the requested type for the specified time period and then 
optionally includes attendance matrices for scouts and/or adults. 

 
If you request an attendance matrix, the report is limited to a maximum of 63 activities. 
On the matrix, the date (MM/DD) of each activity is listed vertically at the top of each 
column. The total attendance for each activity is listed vertically at the bottom of each 
column. Individual totals are shown on the right-hand side of the report. 
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b. Activities List. This report chronologically lists all unit activities (calendar and non-
calendar) for the specified time period. You select the type(s) to be included. Optionally, 
you can include the text description of each activity.  

 
c. Attendance Matrix. This report serves two purposes: (1) a data collection form to record 

attendance at unit activities, and/or (2) a report for viewing previously recorded 
attendance at activities. You can generate the report for scouts and/or adults and 
optionally include each member�s phone number. 

 
If you select more than one activity type on this report, you should also select the 
�Include activity type� option. This will make the report more meaningful. 

 
d. Individual Activity Report. Select one or more activities and TroopMaster will print all 

activity information including attendance and the text description, if any. 
 
e. Individual Participation. Select the time period and activity type(s) to include, and 

TroopMaster will list all qualifying activities that the selected scout(s) or adult(s) 
attended. Totals are provided at the bottom of the report. If no dates are specified for this 
report, you can optionally include amounts listed in the Set Priors area. 

 
f. Participation Summary. This is actually a group of six reports, three on your scouts and 

three on your adults. You can select amount totals, attendance ratios, or attendance 
percentages on one or more activity types. For each scout, TroopMaster will print two 
figures (separated by a slash) for each of the selected type(s). The first figure is the total 
number of activities of that type that the scout/adult attended. The meaning of the second 
figure varies based on the report option you chose: 

 
(1) Amount Totals. The second figure is the total number of nights camped, miles hiked, 

service project hours worked, etc., for that activity type. For activities like meetings, 
the total amount is usually zero. 

 
(2) Attendance Ratios. The second figure is the total number of activities of that type that 

the scout/adult could have attended.  
 
(3) Attendance Percentages. The second figure is the first figure divided by the total 

number of activities of that type that the scout/adult could have attended, expressed as 
a percentage.  

 
Unless you select the �ratios� option, you can optionally include a unit summary. If you 
select �Amount Totals�, the unit summary will show the total number of activities of 
each type and the total amount (e.g., 6 campouts for 12 nights). If you select the 
�Attendance Percentages� option, the unit summary will show the total number of 
activities for each type and the average attendance percentage for your members. 

 
If a scout/adult missed an activity but was either excused (see para. 7.1b(2)) or was not 
yet a member of your unit (based on his �Joined Unit� date), that activity will not be 
considered in his attendance ratio or his attendance percentages. 
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g. Tour Permit Assistance. This option makes it easy to produce a report that contains 
virtually all of the data needed for a Tour Permit. Your council may allow you to sign the 
official BSA tour permit form (to satisfy the legal requirements) and simply attach the 
TroopMaster report (to provide the details). You will enter the needed information on 
three tabs: 

 
(1) General Info. The fields on this tab are taken directly from the official form. Select a 

leader and an assistant from the drop-down list of your adult members. Enter the 
departure and return dates, the numbers of scouts/adults going, and the type of trip. If 
swimming/boating or climbing/rappelling are involved, list the leaders and their 
associated certificate dates. 

 
(2) Itinerary. For each leg of the trip, enter departure/destination points and the number 

of miles. If that leg involves an overnight stop, enter the location and indicate whether 
reservations have been made. Then, click Add Waypoint and TroopMaster will add 
it to the end of the list. If you need to insert a waypoint, highlight the immediately 
preceding waypoint before clicking Add. If you need to adjust the sequence of a 
waypoint, highlight it and click Move Up or Move Down. To delete a waypoint, 
highlight it and click Remove. TroopMaster automatically keeps a running total of 
mileage at the bottom of the dialog but you can manually enter a total, if desired. 

 
(3) Transportation. Use this tab to select your drivers/vehicles and to select the mode(s) 

of transportation to be used. The �Driver� drop-down list contains all of the adults 
and parents who have vehicle information in their records. When a driver is selected, 
the �Vehicle� drop-down list contains that person�s vehicle(s) plus the unit vehicle (if 
any). Select each driver and vehicle, enter the number of passengers, and click Add 
Vehicle. To delete an entry, highlight it and click Remove. 

 
TroopMaster will remember any information entered for a Tour Permit Assistance report 
while the program is running. This is helpful in the event that you start the report and then 
need to switch to a data entry dialog to make changes (e.g., enter a new vehicle for a parent 
or adult member). Entries on the report dialog will discarded if you exit TroopMaster or if 
you click the New Tour Permit button. 

 
h. Unit Activity Totals. For the activity type(s) selected, TroopMaster lists grand totals for 

scouts or adult leaders. The totals include all activities in your active database plus any 
�prior� amounts (see para. 7.2) for each type. 

 
For all activity types, the figures represent the total �Amount� for each type (i.e., nights 
camped, miles hiked, etc.). These figures do not represent the total number of activities 
attended. For example, for meetings the amount is usually zero. 

 
i. Unit Calendar. This report includes all of your scheduled calendar activities for the 

specified type(s) and time period. This report can be generated either as a list-type report 
with activities grouped by month, or in a one-page-per-month, �wall-calendar� format. 
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12.2 Adult Members 
 

Reports specific to your adults are in this area. Reports that can also include scouts, such as 
the recharter report, Medical/Special Needs report, custom reports, and reports related to 
activity attendance, are in other areas. The following reports give you the option of including 
all adult members or just the unit leaders. 

 
a. Adult Phone List. This report lists your adults' names, addresses, phone numbers, and 

leadership positions. Email addresses can optionally be included. 
 
b. Adults Having/Needing Awards/Training. This is a group of four reports that provide 

lists of adults who either have or need a specific training course or special award. Choose 
an award or course name from the menu or type a name in the �Other� field.  

 
When you request the �Needing Training� report, you can optionally include adults whose 
training is old or expired. To do that, click the �Include adults who need retraining� 
checkbox and enter a date in the �Earlier than� field. The report will then include all adults 
who have never had the training plus those whose completion dates are earlier than the date 
specified. 

 
c. General Purpose Worksheet. This extremely flexible worksheet can be used for a 

multitude of purposes. For example, you could use it as a data collection worksheet by 
giving it a title and defining one or more column headers. Optionally, you can choose to 
include selected items from the adults data file, such as date of birth or current leadership 
position.  

 
If you think you might use the same worksheet again, click the Save button and assign it 
a file name. Then, the next time you need the worksheet, just select it from the drop-
down list. If there�s a saved worksheet that you no longer need, select it from the list and 
click Delete. 

 
d. Individual Personal Data. This report lists all of the personal data on a selected adult. It 

also includes special awards earned and training courses completed. 
 
e. User Defined Fields/Remarks. This option provides a powerful way of producing special 

reports on your adults. TroopMaster lets you select any or all of the user defined fields 
from the adult personal data display (see para. 8.1a(1)(d)). The report then lists each of 
your adults and the selected data item(s). 

 
Use this option to produce reports that are not otherwise available in TroopMaster. For 
example, you could define fields #1 and #2 for resource survey information and then print a 
�Resource Survey� report. 

 
12.3 Awards/Advancement 
 

These are the most versatile and powerful reports in the system. All individual and unit-level 
reports related to scout awards and advancement are contained in this area. 
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a. Advancement Status Report. This report provides a complete and concise summary of the 
advancement status of your unit. For each scout, TroopMaster will print a one-line list of 
requirements remaining for his next rank. Requirements are heavily abbreviated but you 
can include a legend at the bottom of the report. Scouts can optionally be grouped by 
rank or by early/senior ranks. 

 
b. Board of Review Report. This report is designed for scouts who are ready for a Board of 

Review (Tenderfoot through Eagle Palms). Scouts who still need �Scout Spirit� and/or 
�Scoutmaster Conference� can also be printed, since those items are often completed on 
the same night as the Board. The report provides all of the information needed by the 
board members, including a list of specific requirements completed, advancement 
remarks, prior rank advancements, and merit badges earned to date. The report also 
includes a certification block in which to record the results of the board. If the scout is 
ready for more than one board (e.g., Tenderfoot and 2nd Class), two reports will be 
printed. 

 
c. Court of Honor Report. This report provides everything you need to set up your Court of 

Honor (except the cookies-we�re still working on that!). The report always includes rank 
badges, merit badges and special awards, but you can optionally include O/A recognition, 
training and service stars. In addition to the required �From-To� dates, there are three 
options related to the use of the �Reported/Presented� flags (see para. 6.3) that govern 
which awards will be included on the report. Included awards can optionally be grouped 
by recipient or by award type/name. 

 
Following the list, TroopMaster includes a list of special awards and service stars earned 
by your adults and an �Awards Summary� of items you need to support the court (i.e., a 
shopping list).. 

 
Whenever you request the Court of Honor report, you have the option of printing copies 
of the Unit Advancement Report, a facsimile of the BSA Form 4403. The BSA National 
Council has authorized local council offices to accept computer-generated substitutes for 
the Form 4403 if they choose to do so. If you select the �Print three copies� option, 
TroopMaster will label them as �Council�, �District,� and �Unit� copies. Sign the council 
and district copies and take them to your council office. 
 
If your council office is on-line with the ScoutNET 2000 computer system, click the 
�ScoutNET� option and, in addition to the paper report, TroopMaster will also create an 
ASCII delimited file on diskette, which you can then submit to your council. The council 
will be able to import your advancement data from this diskette directly into ScoutNET 
2000. The council will also want a signed copy of the paper report certifying its accuracy. 

 
The ScoutNET electronic file is in a special format for use with the ScoutNET system. If 
you open this file manually to view its contents before submitting it to your council 
office, please do not save the file when you are finished viewing it. Many spreadsheet 
programs (e.g., Excel) will save the file in a slightly different format even if you have 
not modified the file. These changes will render the file unusable by ScoutNET. 
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If you select the �Print labels for MB/rank cards� option, TroopMaster will print stick-on 
labels for the rank and merit badges. You can attach these labels to the award cards instead of 
having to fill them out by hand. Signatures are still required. 

 
To get an end-of-year summary of all the awards earned by your scouts, run this report using 
a �From-To� period for your whole charter year and check the �Awards summary only� 
checkbox. If you archived scouts who left the unit during the year, go into the archive and 
print another report for the same time period. Add the totals from the two reports to get your 
grand totals! 

 
If you would like to transfer the award information to a spreadsheet or database management 
system, check the �Create tab-delimited export file� option. After the report has been 
generated, TroopMaster will create and save an awards file to a location you specify. The 
data then can be easily imported from that file into the other software package. 

 
After you have printed or saved the report, TroopMaster will ask if you want to update 
the �Reported/Presented� flags for all awards included on the report. When you 
generate the final copy of the report for submission to your council, you should update 
the R/P flags.  

 
If you choose to update the �Reported� flags, TroopMaster will remember the time period 
used. The next time you display this dialog, TroopMaster will use the �To� date of the 
previous report (plus one day) as the default �From� date for the next report. 

 
If you check the �O/A recognition� option, TroopMaster will lists scouts and adults who 
completed Ordeal, Brotherhood, or Vigil during the time period of the report. Since these are 
recognition only, they won't be included on the Awards Summary. 

 
The scout equipment catalog has service stars for years 1-10, 20, 30, 40, 50, 60, and 70, so 
intermediate years are not included on the Awards Summary. For recognition purposes, they 
are still included on the main report. 

 
d. Individual History Report. This is one of the most flexible reports in the system, allowing 

you to choose exactly what data to include. For example, you can select any or all of the 
rank badges (including Palms). There are numerous other options, such as including O/A, 
special awards, training, leadership history, etc. If you want to save paper, select the 
�Omit details on completed ranks� option and TroopMaster will list only the completion 
dates for completed ranks. 

 
Whenever a scout leaves the unit, select the �Include signature block� option and print two 
copies. Sign the verification block on both copies. Then, give one copy to the scout to carry 
with him to his next unit and put the other copy in a permanent history file. If the scout is 
transferring to another unit that is using TroopMaster ME, you can also transfer his data 
electronically (see para. 5.9) 

 
TroopMaster automatically monitors changes you make to each scout's advancement records. 
One of the options allows you to print this report for all scouts whose advancement has 
changed since their reports were last printed. 
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e. Individual Progress Report. This report provides an easy-to-read summary of 
requirements for the rank toward which the scout is currently working. If Eagle-required 
merit badges are needed, this report will tell you how many and which ones. If he hasn�t 
completed his �Service Project� requirement, the report shows how many more hours are 
needed. The �Position of Responsibility� and 2nd/1st Class �Activities� requirements are 
handled in a similar manner. The report optionally includes a list of prior rank 
advancements and an alphabetized list of merit badges earned to date. Advancement 
remarks and partial merit badges can also be included. 

 
We recommend that you send out copies of this report at least quarterly so that the scouts 
and their parents can review them. A complete alphabetized set can be obtained using the 
�All Scouts� option. These can be emailed (see para. 12.0), mailed home using the 
mailing labels capability, or distributed at Courts of Honor. Letting scouts see their 
current status also provides an unexpected side benefit. After reviewing their reports, 
scouts frequently come and tell you of awards or requirements they completed some time 
ago but forgot to mention! 

 
TroopMaster automatically monitors changes you make to each scout's advancement records. 
One of the options allows you to print this report for all scouts whose advancement has 
changed since their reports were last printed. 

 
f. Merit Badges Earned. This report lists all of the merit badges a scout has earned. Badges 

can be sorted alphabetically, chronologically or grouped by rank. If you request more 
than one scout, you can print each scout on a separate page or print a sequential listing. 

 
g. Merit Badge Matrix. This report lets you select a set of merit badges and produce a 

spreadsheet-type report that lists your scouts and whether or not they have completed 
each of the selected badges. The report will also show you if a scout is currently working 
on any of the badges. A quick selection button lets you highlight all of the Eagle-required 
merit badges, or you can manually select desired badges.  

 
This report can be very helpful in planning summer camp. 

 
h. Partial Merit Badges List. This report lets you review your partial merit badge data in two 

different ways. The first option groups the badges by scout; i.e., the scout's name is 
printed followed by the badges on which he is working. The second option lists the merit 
badges and for each badge, lists the scouts who are working on it. Several other options 
control the level of detail to include. 

 
i. Partial Merit Badge Matrix. This report lets you select a specific badge and produce a 

spreadsheet showing which requirements have been completed by the scouts working on 
it.  

 
You can add or update a partial merit badge for a group of scouts all at once through the 
Advancement>Group Credit>Merit Badges option. 

 
j. Scouts Having/Needing. This is actually a group of several different reports. In addition 

to providing lists of scouts having or needing a specified merit badge, special award, or 
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training course, you can also get lists of scouts who have not yet completed their �Service 
Project� or �Position of Responsibility� requirements. 

 
If you request a list of scouts needing a specific merit badge, special award, or training 
course, TroopMaster will print all scouts who have not yet earned the specified item. For 
merit badges, the report will indicate whether or not the badge can be applied to each 
scout's next rank, and whether or not the scout has started the badge. These reports are 
very useful in organizing a merit badge or special award class and in planning campouts. 

 
The Scouts Needing Camping MB is a special report. The badge requirements state that a 
scout needs 20 nights of camping, not including cabin camping. Also, the 20 nights can 
include no more than one week of summer camp. TroopMaster considers all of these factors 
in computing �Nights Remaining� for each scout. Therefore, a scout could have over 20 
nights total camping but still have nights remaining on this report. 

 
The Scouts Needing World Conservation Award is a special report that shows the status of 
each scout regarding completion of merit badges required for this award (i.e., Citizenship in 
the World, Environmental Science, and either Fish & Wildlife or Soil & Water). 

 
The Service Project report lists 1st Class and Star scouts and scouts below 2nd Class who 
have not completed their service project requirements. This report is useful in planning 
service projects and can also be given to Life scouts when they begin planning their 
Eagle projects. Because of the special nature of Eagle projects, Life scouts are not 
included. If you are tracking service project hours in the activities area of the program, 
this report will tell you how many hours each scout still needs to complete the 
requirement. 
 
The Position of Responsibility report provides a list of all 1st Class, Star, and Life scouts 
who have not yet completed this requirement for their next rank. A �Days Remaining� 
column shows how much time each scout still needs. An asterisk will be printed next to 
the name of each scout who is currently serving in a valid position for the requirement.  

 
When you have unit elections, give a copy of this report to the new senior patrol leader so 
that he can assign these scouts to staff positions. 

 
When you request the �Needing Training� option, you can choose to include scouts whose 
training is old or expired. To do that, click the �Include scouts who need retraining� 
checkbox and enter a date in the �Earlier than� field. The report will then include all scouts 
who have never had the training plus those whose completion dates are earlier than the date 
specified. 

 
k. Scouts Not Advancing. This report lists all scouts who have not advanced since the date 

or time period you specify. Scouts are sorted from the oldest rank advancement to the 
most recent, providing a prioritized list of scouts who need to be counseled. Eagle scouts 
are not included. 

 
l. Target Eagle. This option will produce a spreadsheet report on all scouts working on the 

upper ranks (Star, Life and Eagle). You can optionally include scouts below First Class. 
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For each scout, the report shows which requirements have been completed toward the 
three ranks. 

 
m. Target First Class. This report provides a spreadsheet-type status of the scouts below 1st 

Class and where they stand on early rank requirements. Dialog buttons let you quickly 
select the Citizenship/First Aid, Outdoor Skills, and/or Physical Fitness/Personal 
Development skill groups. The column header buttons will highlight all of the 
requirements in their respective columns. You can also manually select requirements with 
your mouse. Up to 64 requirements can be included on a single report. Optionally, you 
can print the requirement definitions and the number of scouts needing each requirement 
at the bottom of the report. 

 
n. Eagle Application Assistance. When a scout is ready for his Eagle Board of Review, this 

report will help him complete the application. It prints all of the available information in 
the same order as it appears on the application. 

 
o. Palm Application Assistance. This report is useful for Eagle scouts who have finished all 

of the requirements for one of the Palms. It prints all of the needed information in the 
same order as it appears on the application. 

 
p. Eagle Honor Roll. This report will produce a list of Scouts who have earned Eagle with 

your unit. Whenever a scout is promoted to Eagle, you will be asked if you want to add 
the scout to the Eagle Honor Roll. You can enter Eagle scouts manually using the 
Advancement>Eagle Honor Roll option. 

 
12.4 Fundraiser 
 

This set of reports provides you with full details on all sales and payments associated with a 
particular fundraiser. 

 
a. Individual Scout Sales. This report provides details on all items sold by a selected scout, 

including the total dollar amounts associated with those sales. It also lists any payments 
the scout has made, and it calculates the balance due, if any. 

 
b. Scout Sales Matrix. This produces a spreadsheet-style report that shows the quantity sold 

by each scout for each item in the fundraiser. It also calculates total sales by scout and by 
item. The latter figures tells you how many items of each type you will need to fill the 
orders. If you entered wholesale prices for each of the items, TroopMaster will also 
compute your unit�s profit. 

 
c. Payment Summary. For each scout, this report shows each payment he has made, the 

total amount due, and the outstanding balance, if any. Unit totals are listed at the bottom 
of the report. 
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12.5 Mailing Labels/Envelopes 
 

TroopMaster lets you print mailing labels on your scouts, adult members, POCs, and merit 
badge counselors. Scout labels are available in six different formats. You can also print 
custom mailing labels as well as unit return address labels. Optionally, you can include adult 
leader labels whenever you request scout labels. 

 
You can adjust label alignment through the Page Settings tab on the File>Preferences 
dialog. 

 
When printing scout/adult labels, you can choose to print only one label per household. For 
this feature to work, you must first create links between related members in your database. 
For more information on family links, see Chapter 15. 

 
Custom labels enable you to print labels for special mailings. You specify the name/address 
to be printed and the number of copies. For example, you could use this feature to print 
personal return address labels for your Christmas cards! 

 
12.6 Merit Badge Counselors 
 

Reports in this group help you manage and more effectively utilize your MB counselors. 
 

a. Cross Reference. This report consists of two parts. The first is a numbered, alphabetical 
list of your counselors that includes addresses, phone numbers and email addresses. The 
second is an alphabetical list of merit badges with the corresponding numbers of the 
counselors who teach them. The two listings together provide a cross-reference for 
locating counselors for any specific merit badge. This report provides the same 
information as the �Grouped by Badge� report below, but it uses less paper. 

 
b. Detailed Listing. This report lists all of the data on each of your counselors, including the 

badges they teach. 
 
c. Individual Personal Data. This is a single counselor report that includes all of the data on 

a selected counselor, including the badges s/he teaches. 
 
d. Grouped by Badge. This is the easiest report for locating a counselor for a specific merit 

badge. Badges are listed alphabetically with the counselors� names, addresses, phone 
numbers and email addresses under each badge. 

 
e. Merit Badges with No Counselor. This lists all of the badges for which you have no 

counselor. Outdated badges are excluded. 
 
f. Specific Merit Badge. For this report, you specify a badge and TroopMaster lists all of 

the counselors who teach it. 
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12.7 Order of the Arrow 
 

This group includes all of your O/A reports. 
 

a. O/A Eligibility. This report lists all of your scouts and adult leaders who are not O/A 
members. You can optionally include only members who are currently eligible (i.e., meet 
all O/A eligibility criteria), or you can include all non-O/A members and view each 
member�s current status toward eligibility. 

 
To be eligible, scouts and adults under 21 must have earned at least the 1st Class badge. 
All scouts and adults must have experienced 15 nights camping during the two-year 
period prior to the election. The 15 nights must include one, but no more than one, long-
term (five or six nights) camp. In accordance with the O/A Guide for Officers and 
Advisers, the balance of the 15 nights must consist of overnight, weekend, or other short-
term camping. Camping nights from the Set Prior Totals area are not counted since 
TroopMaster has no dates associated with them. Cabin camping is not considered. 

 
b. O/A Membership. The report lists all of the O/A members in your unit. It includes dates 

for O/A Election, Ordeal, Brotherhood, and Vigil, as well as O/A leadership positions 
and remarks. As an option, you can list all recently elected scouts and adults who have 
not yet completed their Ordeal. 

 
c. Adult Individual Member. This report includes all of the data from the O/A member 

dialog for the selected adult. 
 
d. Scout Individual Member. This report includes all of the data from the O/A member 

dialog for the selected scout. 
 
12.8 Points of Contact Reports 
 

There are two reports available. 
 

a. Individual Personal Data. This report includes all of the data from the POC dialog for the 
selected individual. 

 
b. POC List. This is one of the most flexible reports in the system. You can list information 

on your POCs alphabetically, grouped by category, or for a specific category. POCs can 
be sorted by name or position. You can even search for specific skills or interests and 
have TroopMaster look for a match on any or all of your entries. POC remarks can 
optionally be included. 

 
The POC skills/interests search looks for matches based on full or partial entries made on this 
dialog. For example, if you enter �Tra�, TroopMaster would match POCs whose �interests� 
include �Transportation� or �Training.� 

 
12.9 Scout/Unit General 
 

This group includes a wide variety of rosters, phone lists, and general information reports. 
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a. Individual Personal Data. This report lists all of the personal data on a selected scout. A 
blank report is available for data collection (see Reports>Forms). 

 
b. User Defined Fields/Remarks. This option provides a powerful way of producing special 

reports on your scouts. TroopMaster lets you select any or all of the user-defined fields 
from the scout personal data dialog. The report then lists each of your scouts and the 
selected data items. 

 
Use this option to produce reports that are not otherwise available in TroopMaster. For 
example, you could define fields #1 and #2 for hobbies and special interests and then print a 
�Hobbies and Special Interests� report. 

 
c. Scout Leadership History. This report allows you to produce a list of all of the leadership 

positions a scout has served in, including his current position(s). This is useful at election 
time to see which positions each scout has not experienced. 

 
d. Scout Leadership Roster. This report lists all of your scouts who currently hold a 

leadership position. It groups the scouts into three sections on the report. The first section 
contains the main unit leaders (i.e., SPL, ASPL). The second section lists all of the Patrol 
Leaders and Asst Patrol Leaders. The last group contains all other scouts who have a 
position of responsibility. You can optionally include a list of vacant leadership positions. 

 
e. Birthday List. This report groups your scouts and adult leaders by birth month and shows 

the age each scout will be on his next birthday. 
 

f. Council Recharter/Annual Recharter. If your council office is on-line with BSA�s 
ScoutNET 2000 computer system, this option enables you to generate your annual 
recharter report and write that report to an ASCII delimited file on diskette, which you 
can then submit to your council office. The council will be able to import your data from 
this diskette directly into ScoutNET. TroopMaster will also print an associated paper 
report with signature blocks for you to certify the accuracy of your submission. Both the 
diskette and paper report must be submitted. 

 
Most of the data used to generate the report is obtained from the Unit General 
Information dialog and the scout/adult personal data dialogs. You will enter the rest of 
the necessary information using two other dialogs: 

 
(1) Recharter Information. This is the basic information needed to generate the report. It 

includes the old charter expiration date (obtained from the Unit General Information 
dialog) and the new expiration date, as well as your meeting day, frequency, and time. 
Some units have an official number that is different from the one they commonly use, 
so you can change the number here, if necessary. The unit term is usually 12 months, 
unless the unit is new or the council is restructuring their recharter alignment. The 
�Pricing� figures list the costs that were in effect when this version of TroopMaster 
was developed. These can be adjusted as changes occur. This dialog includes 
checkboxes for Leader Trained, Quality Unit, 100% Boys Life, and Bulk Mailing.  

 
Some councils require an additional $1.00 for insurance. However, insurance is not part of 
ScoutNET, so you must handle that through your council separately  
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When you have completed your entries on the dialog, click Next to proceed. 
 

(2) Recharter Selection. This dialog is used to select the scouts and adults who will be 
chartered and to indicate each member�s charter status. For example, highlight the 
names of the scouts you plan to register and click the Paid button. Other charter 
status buttons allow you to mark members as Transfer, Multiple, or Non-
registering. Please consult your BSA unit renewal instructions for specific guidance 
on each of these status codes. To clear an entry for a specific member, highlight the 
name and click Clear. 

 
If an adult is currently assigned to multiple leadership positions, s/he will appear in the list 
more than once unless the positions have the same two-character BSA position code. This 
allows you to choose the position in which the adult will be chartered (if any). 

 
BSA recharter rules require that you charter adult leaders in certain key positions based on 
the type of unit being chartered, but you generally do not have to charter all of the adults in 
your unit. Please consult with your Unit Commissioner for guidance on required positions. 

 
One of the key adult leader positions is "Executive Officer" and you must select this person 
for rechartering. This position used to be called "Institutional Head" (hence the position code 
of �IH�). The Executive Officer does not have to pay. S/he is always chartered as a 
"Multiple". 

 
Please do not use the �Non-registering� status code for all of the adults whom are not being 
registered. �Non-registering� is for rare cases where you have an adult whom you�re not 
going to register, but for whom you want to send data anyway 

 
When you are finished, click OK on the Recharter Selection dialog to generate the 
report. TroopMaster will automatically review all of your data to ensure that your unit 
meets BSA recharter standards. If any discrepancies are encountered, an error 
message will pop-up before the report is displayed. The report cover sheet includes a 
specific list of problems encountered. This makes it easy to see what you need to 
correct in order to meet BSA standards. 

 
If you checked the "LDS Unit" checkbox on the Unit General Information dialog, 
TroopMaster will apply LDS rechartering rules when it validates your recharter report. For 
example, under LDS rules, Boy Scouts must be age 11-13, Varsity Scouts must be 14-15, and 
Crew Members must be 16-20. This usually means that you must create a separate recharter 
report for each group, making sure that you select the appropriate set of adults/scouts for 
each report. For example, when you charter the crew you must include a Venture Crew 
Advisor. If you charter the same adult on more than one report, s/he should be marked as 
"Paid" on one and "Multiple" on the others. 

 
When you are satisfied with the results, print the paper report and then click Close. 
TroopMaster will then save the recharter transfer file to a diskette to give to your council. 
Remember to sign the printed report and submit that with the diskette. 
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There are three fields that appear on the paper report that cannot be set from within the 
program: County, Unit Status, and On Time Unit. These fields are not part of the ScoutNET 
data transfer file that is written to diskette, and entries in these fields must be made manually. 
The "County" entry is self-explanatory. The district leader completes the �On Time Unit� 
field, which indicates whether or not you submitted your recharter report on time. The 
District Leader also completes the "Unit Status" field 

 
The official ScoutNET printed report does not contain all of the data contained in the 
electronic transfer file. If you would like to see a printed copy of other data being 
transmitted, check the �Print copy of transmittal file� checkbox, and TroopMaster will 
produce a separate unit report. 

 
Recharter selections you make are retained until you exit the program. 

 
g. Council Recharter/Additional Enrollment. Use this report to submit data to your council 

on new scouts and adults who join your unit mid-year. This option will create an ASCII 
delimited file similar to the Annual Recharter report. Your council will be able to import 
the data from this diskette directly into ScoutNET. TroopMaster will also print an 
associated paper report for you to verify the accuracy of your submission. Both the 
diskette and paper report must be submitted. 

 
h. Email List. This report produces a list of email addresses for your scouts, parents and 

adults. 
 
i. General Purpose Worksheet. This extremely flexible worksheet can be used for a 

multitude of purposes. For example you could use it as a data collection worksheet by 
giving it a title and defining one or more column headers. Optionally, you can choose to 
include selected items from the scouts data file, such as date of birth or current leadership 
position.  

 
If you think you might use the same worksheet again, click the Save button and assign it 
a file name. Then, the next time you need the worksheet, just select it from the drop-
down list. If there�s a saved worksheet that you no longer need, select it from the list and 
click Delete. 

 
j. General Purpose Matrix. This option produces a spreadsheet-type report similar to the 

General Purpose Worksheet. You can define up to 65 column headers for this report, 
which makes it very useful for making a checklist of items for your scouts and/or adults. 
Just assign the report a title and then define as many column headers as you like. For each 
column, enter the header text and click Add. If you need to adjust the sequence, highlight 
the header that you need to relocate and click Move Up or Move Down. If you also want 
to have columns with no predefined header, set the �Number of columns� field to the 
total number of columns desired. 

 
If you think you might use the same matrix again, click the Save button and assign it a 
file name. Then, the next time you need the matrix, just select it from the drop-down list. 
If there�s a saved matrix that you no longer need, select it from the list and click Delete. 
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k. Medical/Special Needs. This report lists your scouts and/or adults and any medical and/or 
special needs data that you entered for them on the �Personal #2� tab of their personal 
data dialogs. Medical information includes items like doctor�s name and phone number, 
emergency contact, health insurance, dates and classes of physical exams, etc. Special 
needs data relates to conditions like learning disabilities, visual/hearing impairments, 
emotional difficulties, etc.  

  
l. Photo Directory. If you have scanned and entered photos for your members, this option 

will produce a photo directory on your scouts and/or adults. This can be especially useful 
to help new leaders familiarize themselves with your scouts. 

 
m. Physical Exam Status. This report lists your scouts and/or adults along with dates for all 

three classes of physical examinations. Physicals that have expired (based on a date you 
specify) will be flagged with an asterisk. 

 
By entering a future date you can see who will need physicals for a planned activity, such as 
summer camp. 

 
n. Service Years. This report shows the service year status of your scouts/adults. For scouts, 

service is based on the �Joined Unit� date adjusted by �Prior Service�, if any. For adults, 
service is based on the �Became Leader� date adjusted by �Prior Service�, if any. 

 
o. Unit General Information. This report contains all of the information from the Unit 

General Information dialog (see para. 4.1). 
 
p. Unit/Patrol Awards. This report produces a list of all awards earned by the unit and/or 

individual patrols. 
 
q. Unit Phone List. This report lists your scouts and their home or mailing addresses, phone 

numbers, and email addresses; parents' names, phone numbers, and email addresses; and, 
optionally, alternate parents' names, phone numbers, and email addresses. You can also 
elect to include your adult leaders on this report. 

 
r. Unit Roster. This extremely flexible roster provides a list of your scouts with ranks, 

patrol names, and leadership positions. You can print the roster alphabetically, by 
birthday, grouped by patrol, or grouped by rank. You can optionally choose to include the 
scouts� addresses and parents� names on the roster. 

 
The �Sort By Birthday� option is designed to help LDS units know when to move scouts up 
to the next level. 

 
When grouping by patrol, Patrol Advisors are included with their patrols. 

 
s. Unit Vehicles. This report lists the vehicle information (e.g., make/model, insurance, etc.) 

on the vehicles entered on the scout/adult personal data dialogs. Using the �flag� option, 
you can print a list of just those parents and other adults who will drive for a specific 
activity.  
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12.10 Venturing 
 

These reports enable you to track your Venturing awards at the unit and individual scout 
levels. 

 
a. Award Status Summary. This very flexible report allows you to select any of the five 

Bronze Awards or the Gold/Silver Awards and view progress toward the award for 
selected scouts. Only those scouts who have been marked as Venturers on the Individual 
Advancement dialog will be included on the selection list. TroopMaster will generate a 
report that shows the award requirements at the top and then prints a spreadsheet-type 
status summary showing the selected scouts and which requirements each scout has 
completed. As with the associated data entry dialog, the Bronze and Ranger Awards 
share the same report. 

 
 b. Bronze Awards Report. This option lets you print individual reports on each of the 

selected scouts for any of the selected Bronze Awards. You can select as many scouts and 
awards as you like. If you don�t select any awards, TroopMaster will print the "primary" 
bronze award (see para. 6.12) for each of the selected scouts plus any other Bronze 
Awards toward which the scout has finished any of the requirements. If you are 
generating reports on several scouts and you only want the report to include those awards 
NOT designated as primary (since the primary Bronze Award is always included on the 
Gold/Silver Award report anyway), select the desired scouts and awards and then turn the 
"Include primary bronze" checkbox off. 

 
c. Gold/Silver Award Report. This option will generate individual reports on each of the 

selected scouts showing his progress toward the Gold and Silver awards. For each scout, 
TroopMaster will also include whichever Bronze Award has been designated as his 
"primary" Bronze.  

 
12.11 Custom 
 

This option allows you to create custom reports on your scouts and adults by choosing 
specific data fields to include on the report. For example, you may wish to generate a one-
line-per-scout phone list, including each scout�s name, home phone, cell phone, and email 
address. Or you can turn it into a two-line report and add items like current rank, date of 
rank, and leadership position. In addition to selecting which data fields to include, you can 
enter a report title. 

 
If you think you might use the same report again, click the Save button and assign it a file 
name. Then, the next time you need the report, just select it from the drop-down list. If 
there�s a saved report that you no longer need, select it from the list and click Delete. 

 
 
12.12 Forms 
 

These forms are primarily to help with data collection but this area also includes permission 
slips. 
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a. Data Collection Forms. To help you gather the data TroopMaster needs on your scouts, 
adults, merit badge counselors, and POCs, there are separate personal data collection 
forms on each group as well as an advancement (Individual History) form for your 
scouts. 

 
b. Permission Forms. This option makes it easy to print personalized permission slips for 

unit outings. We have developed a default permission form with verbiage that we believe 
will be useful to many units. However, you can change the wording for the body of the 
default form to meet the legal requirements in your area and the specific needs of your 
unit. You can also create and save multiple permission form �masters� for different types 
of activities. 

 
Once you have reviewed/modified the body text for the form, select the scouts for whom 
you want to generate permission slips. You can select specific scouts, all scouts, or use 
the �Flag Scouts� feature to select desired scouts. Whenever you generate permission 
slips, TroopMaster will print one slip per scout with each scout�s name on the form. If 
your permission forms are sufficiently concise, you can elect to print two per page. 

  
Troopmaster Software, Inc. makes no guarantee that the wording we have provided is 
legally acceptable in your area, nor do we guarantee that it adequately protects your 
unit against liability lawsuits. It is your responsibility to adjust the wording as 
necessary to meet your needs and the legal requirements in your area. We strongly 
recommend consulting an attorney and your council office to ensure that the final 
wording you choose satisfies your legal needs. 

 
12.13 Other 
 

This is a group of miscellaneous lists and worksheets. In addition to a Merit Badge Book 
Inventory Worksheet, you can print lists of predefined and user-defined menu items such as 
flag definitions, merit badge identifiers, POC categories, special award names, training 
courses and leadership positions. 
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CHAPTER 13. ARCHIVING 
 
13.0 Overview 
 

TroopMaster provides an archive for scouts and adults who leave your unit. The archive data 
is completely separate from your active unit data, but a scout or adult can be retrieved from 
the archive if he later returns to your unit. 

 
13.1 Creating an Archive 
 

We recommend keeping the archive on a hard drive but you can use a zip drive, if desired. 
An archive is initially created for you as a subfolder under the main program folder (e.g., 
C:\TroopMaster ME\Archive). Up to 250 scouts and 250 adults can be stored in a single 
archive. If the initial archive fills up, create another via the File>Create New Archive option. 

 
Archives cannot be created on a floppy diskette. 

 
13.2 Archiving Scouts/Adults 
 

To archive a scout or adult, retrieve his personal data dialog. Click Del/Archive, check the 
�Archive� option on the pop-up window, and enter the date he left your unit. If you click 
OK, TroopMaster will archive the selected member and then delete him from your active 
unit files. If your are archiving a scout who is at least 17 years old, TroopMaster gives you 
the option of also copying his pertinent data to your active adults file. 

 
Archiving a member saves his personal data, special awards, training, leadership history, O/A 
information, and attendance. The member's current leadership position(s), if any, will be 
closed out and moved to his leadership history file. In addition, the member�s �Joined Unit� 
date will be erased and his service with your unit will be added to his �Prior Service� area. If 
the member is a scout, all advancement data is also archived. 

 
Archiving a scout or an adult saves a small file that can be used to restore the member�s 
attendance if he is later retrieved from the archive back into the active unit. The associated 
activities themselves are not archived, and activities/attendance cannot be reviewed or 
printed from the archive. 

 
13.3 Reviewing Your Archive 
 

To review your archive or print reports on archived scouts and adults, select the File>Open 
Archive Files option. TroopMaster remembers where your archive was last accessed and will 
present that path as the default. To remind you that you are in the archive, the words 
�Archive Files� will be displayed on the title bar. While in the archive, some options (e.g., 
activities, POCs, etc) are not available. However, you can add or review archived 
scouts/adults, edit data entries, print reports, etc. 
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Scouts/adults who left your unit before you purchased TroopMaster can be added directly to 
the archive via the �Add New� member options. 

 
13.4 Retrieving Members From the Archive 
 

If you need to retrieve an archived scout or adult back into your active unit files, go to the 
Scouts or Adult Members menu and select Retrieve from Archive. Select the name of the 
member you want to retrieve from the pop-up list and click Retrieve. 
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CHAPTER 14. MAKING BACKUPS 
 
14.0 Overview 
 

It is hard to overstate the importance of making backups. Maintaining your active database 
and archive requires a lot of work. Protect that work by following the procedures in this 
chapter carefully. 

 
TroopMaster uses file compression technology for backups. Your active database or archive 
will be compressed into a single, small file. Don�t be alarmed at the speed of the backup and 
the small size of the backup file. You will not be able to read this file with any of your other 
programs, nor will you be able to decompress it with any other program 

 
14.1 Backing Up Your Unit Data 
 

Your unit data represents a major investment of your time. It is extremely important that you 
make frequent backups of this data. Don't let a hard drive failure force you to reenter most or 
all of your data from scratch. We recommend making a backup after each data entry session 
(don't wait until you get your whole unit entered before you make your first backup!). In 
addition, don�t always use the same backup diskette or folder. If your hard drive becomes 
corrupted, it is possible to damage your primary database and the backup before you 
recognize the problem. 

 
Because of this, we recommend that you maintain at least two backups. Alternate between 
these backup diskettes or folders each time you backup your data files. By alternating, you 
greatly increase your chances of being able to recover from a damaged file. 
 
Whenever you exit the program, TroopMaster will give you the option of automatically 
backing up your active unit data. You can also request a backup through the File>Backup 
Data Files option. Unless your backup includes scout/adult photos, you will only need a 
single diskette. 

 
Photo files are large and they do not compress significantly. Therefore, if you select the 
�Include photos� option on a backup, the backup file may not fit on a single diskette. If 
not, you�ll need to backup to a larger medium, such as a zip cartridge, a CD, or another 
hard drive folder. 

 
14.2 Backing Up Your Archive 
 

To backup your archive, select File>Backup Data Files and click the archive option. Unless 
you�re backing up photos, your archive backup will normally fit on the same diskette with a 
backup of your active unit data. 
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CHAPTER 15. FAMILY LINKS 
 
15.0 Overview 
 

Links provide a powerful way to tie related data records together for concurrent update of 
common data fields. You can link siblings together plus you can link parents to adult 
members, merit badge counselors, or POCs. You can also create links between adult 
members, merit badge counselors, and/or POCs, independent of the parent links. Once these 
database records have been linked, all common information between the records will be 
updated each time any of the linked records is updated. 

 
For example, if a parent is also an adult member and a merit badge counselor, linking the 
three records together will not only reduce initial data entry but also make it easier to 
maintain these records. 

 
15.1 Link Siblings 
 

If the brother of an existing scout joins the unit, go to the Add New Scout dialog and enter the 
last name of the second brother. If the last name matches an existing last name of a scout in 
the system, TroopMaster will automatically offer to create a family link. Otherwise, click the 
Link Sibling button to display a list of scouts. In either case, select the brother from the pop-
up list. TroopMaster will then create a link between the two records and copy the common 
household information from the existing brother�s record to the dialog being displayed. 

 
Common data fields for brothers include home phone, addresses, parent information, and 
alternate relative information. Existing sibling links are displayed in the �Siblings� drop-
down list box on the �Personal #1� tab of this dialog. 

 
15.2 Link Parents and Adults 
 

You can link parents and adult records together from either the adult personal data dialog or 
from the �Parents� tab on the scout personal data dialog. You can create a link from the 
�Parents� tab whether or not the adult member record already exists. Click the �Link to� box 
and from the pop-up dialog, select an existing adult member or click Create New to create a 
new adult record.  

 
If you create the link from the adult personal data dialog, you can only link to an existing 
parent. If the adult does not exist in the �parents� area, enter the scout/parent data first and 
then create a new adult member record from the �Parents� tab. 

 
If you create a new link to an existing record, TroopMaster will always update the 
currently displayed dialog with data from the selected record. For example, if a person 
has been entered in both the �parents� area and the �adults� area, going to the 
�Parents� tab on the scout personal data dialog and creating a link to the adult member 
will copy the data from the adult�s record to the scout personal data dialog. If the 
parent�s data is more current than the data in the adult record, you should go to the 
adult personal data dialog to create the link. 
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15.3 Link Parents and Merit Badge Counselors 
 

Linking parents with merit badge counselors is accomplished in the same manner as for 
parents and adult members. 

 
15.4 Link Parents and POCs 
 

Linking parents with POCs is accomplished in the same manner as for parents and adult 
members. 

 
15.5 Link Adults and Merit Badge Counselors 
 

You can link adults and merit badge counselors together from either the adult personal data 
dialog or the merit badge counselor dialog. From either area, you can choose to create a new 
record in the other file or you can link to an existing record. 

 
15.6 Link Adults and POCs 
 

You can link adults and POCs together from either the adult personal data dialog or the POCs 
dialog. From either area, you can choose to create a new record in the other file or you can 
link to an existing record. 

 
15.7 Link POCs and Merit Badge Counselors 
 

You can link POCs and merit badge counselors together from either the POCs dialog or the 
merit badge counselor dialog. From either area, you can choose to create a new record in the 
other file or you can link to an existing record. 

 
15.8 Quick Access Buttons 
 

Quick access buttons give you a way to move quickly to a linked record once a link has been 
established. This allows you to review information on the associated parent, adult, merit 
badge counselor, or POC from any of the other areas. Just click the button next to the link 
checkbox. 

 
Deleting one of the linked records breaks the link but it does not automatically delete the 
other record. For example, if you delete a scout whose parent is linked to an adult member 
record, the adult record will still exist. 

 
You can break an existing link by turning the associated checkbox off from either area. 
Exception: The only way to break a sibling link is to archive one of the scouts and then 
retrieve him back from the archive. 
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If an existing member is currently linked to more that one other area and you wish to break 
the links to that member, you should go to that member�s personal data area and break all 
existing links for that member. If any links are still active, TroopMaster will automatically 
regenerate the link that you have just broken because the remaining links still point to the 
same record(s). 
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APPENDIX A. SYSTEM LIMITATIONS 
 

TroopMaster will not let you exceed the following limits: 
 

- 250 scouts 
- 24 patrols 
- 80 special awards per scout 
- 20 training classes per scout 
- 135 merit badges per scout 
- 15 leadership history positions per scout 
- 250 adult members 
- 30 special awards per adult 
- 30 training courses per adult 
- 200 merit badge counselors 
- 30 merit badges per counselor 
- 200 points of contact 
- 15 unit activity types 
- 1000 total activities 
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APPENDIX B. AUTOMATIC MONITORING & 
CREDITING OF ADVANCEMENT REQUIREMENTS 
 

TroopMaster monitors several of the advancement requirements and will automatically enter 
a completion date in the scout�s advancement records for you when the requirement has been 
completed.  

 
(1) 2nd/1st Class Activities Requirements. For 2nd Class, a scout must attend five activities 

(not including troop/patrol meetings) of which at least two must be overnight campouts. 
For 1st Class, the required number is 10 activities, of which at least three must be 
campouts. TroopMaster will monitor scout attendance at activities and automatically 
credit both of these requirements when they are complete. The Individual Progress report 
shows the number of activities still needed by each applicable scout. 

 
(2) Participation Requirements. The Star, Life, Eagle, and Eagle Palm �Participation� 

requirements are based on the date a scout earned the previous rank, the number of 
months the scout must serve in that rank, and �Today's Date.� When TroopMaster sees 
that the scout has served the minimum time, it will automatically enter a completion date 
in the scout�s advancement records. The projected completion date is shown on the 
scout�s Individual Progress report. 

 
If desired, you can turn off automatic credit of this requirement by checking the �Inactive� 
checkbox on a scout�s Individual Advancement dialog. 

 
(3) Position of Responsibility Requirements. Automatic crediting of the �Position of 

Responsibility� requirements works the same way as �Participation� except that there are 
additional restrictions. First, the scout must be serving in a valid position for the next 
rank (see your Scout Handbook for a list of valid positions for each rank-the positions 
vary). Secondly, he must serve in this position while holding the previous rank. For 
example, if the scout is working toward Life, the Scout Handbook states �While a Star 
scout, serve actively for six months...�. Therefore, TroopMaster will key the completion 
date off of the date the scout assumed the position of responsibility or the date he became 
a Star scout, whichever is later. 

 
In tracking this requirement, TroopMaster considers the scout�s current position #1 
plus any creditable positions in the scout's leadership history area. Position #2 is never 
considered. A position is counted toward the requirement if the �Credit� checkbox is 
checked. The Individual Progress report shows the number of days remaining for 
applicable scouts. 

 
If you accidentally assign a scout to the wrong leadership position or use the wrong 
effective date, be careful when you correct the error. If you modify the position or date 
and enter a newer position date, the previous entry will be moved to the scout�s 
leadership history. If that happens, highlight the erroneous position on the history list 
and click Remove. Otherwise, the erroneous entry could be used toward automatic 
credit of the requirement. 
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(4) Service Project Requirements. The 2nd Class rank has a one-hour service project 
requirement and the Star/Life ranks each require six hours. TroopMaster will monitor 
scout attendance at service projects and automatically credit these requirements when 
they are complete. As with the �Position of Responsibility� requirement, the six hours of 
service needed for Star/Life must be completed since the date the scout earned the 
previous rank. The Individual Progress report shows the number of hours still needed by 
each applicable scout. 

 
When crediting activity attendance, TroopMaster will let you credit individual scouts with 
differing numbers of hours served. Just use the appropriate number (hours and tenths) as each 
scout�s attendance marker. 
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APPENDIX C. PROCESSING OF EAGLE-REQUIRED 
MERIT BADGES 
 

TroopMaster monitors entry of Eagle-required merit badges to help ensure that the minimum 
number has been earned before a scout can be credited with Star, Life, or Eagle. In doing 
this, TroopMaster complies with BSA rules as defined in the Boy Scout Requirements 
Booklet and the Boy Scout Handbook. If there are any uncertainties, we contact the BSA 
National Council to ensure that our interpretation of the rules is correct. 
 
BSA recently changed the Eagle-required merit badge list and those changes became 
mandatory on April 1, 1999. Many units will have some scouts who earned Eagle under the 
old badge list, some who earned Eagle entirely under the new badge list, and some who 
earned Star and possibly Life under the old list but who must now finish Life and/or Eagle 
under the new list. You may even have a scout who earned Eagle before Family Life became 
a required badge. You (and TroopMaster) need to be able to handle all of this, so it is 
important to understand the different badge lists and how they apply.  
 
There are currently 15 Eagle-required merit badges divided into 12 categories, but the 
numbers of badges/categories and the content of the categories have changed over the past 
few years. The following categories have been valid for many years and are still valid under 
the 1999 rules: (a) Camping, (b) Citizenship in the Community, (c) Citizenship in the Nation, 
(d) Citizenship in the World, (e) Communications, (f) Emergency Preparedness or 
Lifesaving, (g) Environmental Science, (h) First Aid, and (i) Personal Management. The 
remaining categories vary according to time period: 

 
(1) Prior to Sept 1994, there were two other categories:  

 
Safety 
Personal Fitness or Sports or Swimming. 

 
(2) From Sept 1994 until Mar of 1999, there were three other categories:  

 
Safety  
Personal Fitness or Sports or Swimming 
Family Life. 

 
(3) As of Jan 1999, these last three categories changed:  

 
Personal Fitness 
Cycling or Hiking or Swimming 
Family Life 
 

As you can see, badge lists #2 and #3 overlap between January and March of 1999. This 
means that during the three-month transition period to the new rules, a scout could have 
legally completed a rank using either badge list.  
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If a scout completed all of the rank requirements except his Board of Review by March 31, 
1999, he could have gotten his Board of Review later and still used the pre-1999 rules. 
However, if any other rank requirement was still open on April 1, 1999, he must have 
completed the rank under the new rules.  

 
If you have a scout who earned Star or Life prior to April 1999 and has since not 
completed any new requirements, TroopMaster will still be applying list #2 to that 
scout. In that case, you must enter a date of 4/1/99 or later on his next rank dialog in 
order to force him over to the new rules. For example, change his �Participation� date 
to 4/1/99. 

 
Cycling and/or Hiking could not be counted as Eagle-required badges for a rank if the Board 
of Review was earlier than January 1, 1999. 

 
For a scout to earn the Life rank using badge list #3, he must have a total of seven Eagle-
required badges from list #3. For example, let�s suppose a scout earned Star under list #2 
using Basketry, Archery, First Aid, Camping, Safety, and Sports as his merit badges. In order 
to earn Life using list #3, he would then have to complete five more Eagle-required badges 
because Safety and Sports cannot be counted toward the needed total of seven. This is based 
on guidance we received from BSA National. 

 
As you can see, all of this can get very complicated. To help you out, we modified 
TroopMaster to handle as much of this for you as possible. The program has a powerful 
automatic merit badge placement feature. TroopMaster will automatically monitor all of your 
entries in each scout�s advancement records to determine which badge list(s) are applicable 
to each scout. Using this information, TroopMaster then computes the best possible 
arrangement of his completed merit badges to expedite completion of his next rank. 
 
For example, if TroopMaster determines that the scout could legally complete Star under 
badge list #2 or #3, it will compare the number of list #2 badges he has to the number of list 
#3 badges. Whichever list gives him the most Eagle badges toward Star is the one it will use. 
If this comparison results in a tie, TroopMaster will go with list #3. However, TroopMaster 
will reevaluate the badge placement after every new advancement entry. For example, if you 
enter a service project completion date of 4/2/99, TroopMaster will abandon badge list #2 
option and switch to badge list #3. 

 
If you would prefer not to use this new automatic badge placement feature, check the 
�Manual MB Placement� checkbox for the scout and you can then place each merit 
badge under any rank desired. On each rank dialog, TroopMaster will let you know 
how many of the remaining badges must be Eagle-required and it will prevent you from 
placing too many non-Eagle badges on a rank. However, the program will not stop you 
from entering a merit badge under the �wrong� rank. For example, even if a scout still 
needs Eagle-required badges for Star, TroopMaster will not stop you from entering an 
Eagle-required badge under Life. In selecting manual mode, you are assuming most of 
the burden for ensuring that the scout advances according to BSA rules. 
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If �Manual MB placement � has not been selected, a merit badge you credit via group 
advancement or the individual rank dialogs will be placed in exactly the same manner as if 
you had entered the badge on the Merit Badges-Completed dialog.  

 
If you have one or more disabled scouts who are not required to earn the standard Eagle-
required badges, please see Appendix D. 

 
There is one other area that even many long-term Scouters do not fully understand because 
the rules are different for the Eagle rank than they are for Star and Life: 

 
(1) The Star rank requires four merit badges from the Eagle-required list and the Life rank 

requires three. The required list has 15 merit badges in 12 categories. Any of these 15 
merit badges may be counted as Eagle-required for Star and Life. (This rule is in the Boy 
Scout Handbook) 

 
(2) The Eagle rank requires a total of 21 merit badges, including one from each of the 12 

Eagle-required categories. 
 

Therefore, if a scout earns the Emergency Preparedness and Lifesaving merit badges, both 
can be counted as Eagle-required merit badges for Star/Life even though both badges are 
from the same category. However, the scout must still earn a badge from each of the other 11 
Eagle-required categories in order to earn the Eagle rank. 
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APPENDIX D. DISABLED SCOUTS 
 

TroopMaster includes a feature that allows you to disable the Eagle-required merit badge 
rules for selected scouts. If you have one or more scouts who are being allowed to complete 
alternative badges, bring up his Individual Advancement dialog and press ALT-D. This will 
open up a new �Disable Eagle MB rules� checkbox on this dialog.  
 
To turn off the Eagle-required merit badge rules, check this box. You will be asked to 
confirm the request. If you do, the standard Eagle-required status messages on the Star, Life, 
and Eagle dialogs for the scout will be replaced with the following message: �Eagle MB 
rules checking has been disabled.�  
 
TroopMaster will not perform any Eagle-required merit badge checks for a disabled scout. 
You will be able to enter any merit badge under any rank. Also, reports such as the 
Individual Progress report and the Unit Advancement Status report will only show how many 
total badges the scout needs for his next rank. It is up to you to ensure that the scout gets all 
of the badges needed for promotion to Eagle. 

 
If you want to restore Eagle rules checking for a scout, clear the �Disable Eagle MB rules� 
checkbox. TroopMaster will revert to automatic badge placement mode and will sort and 
reapply every merit badge the scout has earned. When it finishes placing the badges, any 
Boards of Review that are no longer valid will be erased and, if appropriate, the scout will be 
demoted. 
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APPENDIX E. TECHNICAL SUPPORT 
 

Virtually everything you need to know about using TroopMaster is readily available without 
your having to contact us. We recommend the following approach: 

 
(1) First, consult the on-line help. Every dialog has a Help button that will display the 

section of the manual applicable to the dialog being displayed. Also, the main menu has a 
Help option that gives you access to the on-line help through several different avenues, 
including an index �search� feature. 

 
(2) Consult the User Manual. To see it, start TroopMaster and select Help/View User 

Manual (requires Acrobat Reader 3.0 or newer). 
 
(3) Visit the �Frequently Asked Questions� (FAQs) page on our web site. There is a separate 

FAQs page for TroopMaster. 
 

If you still cannot find the answer you need, contact us directly. While we cannot accept 
collect phone calls, we are available to answer questions at 434-589-6788 (Mon-Fri 9AM-
5PM EST). Simple questions can also be handled by e-mail (tsi@troopmaster.com). Detailed 
questions require that you call us. If necessary, we can also be available after normal office 
hours on an appointment basis. 
 
Replacement diskettes or CDs outside of the warranty period are $10. 

 
We have always tried to provide the very best technical support available, completely free to 
our users. However, the advent of email threatens our ability to continue doing that. For 
many of the email questions we get, the answer is easily available through the on-line help or 
the User Manual. Please help us keep our user support free by not contacting us directly 
unless you cannot find the answer you need. 
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